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The ForestSimulator based on the software 
package TreeGrOSS 

1 Overview
The ForestSimulator was developed to analyze and evaluate forest stands and their 
development. The program focuses on the handling of  single stands. It offers vari-
ous methods to create virtual forest stands either without data or by reading exist-
ing  stand  data.  Stand  treatment  and  the  assortment  of  harvested  tree  can  be 
defined by user dialogs. These definitions are used in combination with the defined 
forest growth model to model the forest stand development. Reports about the 
growth, the treatment, the harvested volume and the assortment can be generated 
after each simulated 5 year period. Furthermore it is possible to visualize the stand 
2 and 3 D. Both illustrations are interactive. The user can mark trees for thinning 
and harvesting, as well as for protection (habitat trees). The manipulated and simu-
lated stands can be saved and used at a later point time. This way it is possible to 
analyse different development strategies of  one forest stand.
The program offers interesting functions for different users. The foresters from 
the field can simulate different silvicultural options, analyze the consequences and 
use the information for his decision. For teaching and education the program can 
be used for example to explain thinning and harvesting concepts. In strategic plan-
ning it can be used to find a reasonable treatment solution.
   

 

2 Installation 
In this manual the installation of  the ForestSimulator will be described only for 
Microsoft Windows and the Linux operating system Ubuntu. The ForestSimulator 
can be also used on all other operating system with an available Java Runtime En-
gine. The program has been tested on MS Windows and Ubuntu operating sys-
tems. 
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2.1 Requirements
The program is written in Java and it ca therefore be used on nearly every operat-
ing system. All you will need is:

• The Java Runtime Engine (JRE) 1.6.0 or higher Version. To install the JRE 
you might need administration rights for your computer. 

• Java 3D if  you want to use the 3D-graphics. 
You need to install the JRE before Java3D. If  the JRE on your computer 
gets updated it might be necessary to reinstall java 3D. 

The installation on Windows is  simple  if  you use the Setup-programs.  For 
Linux operating systems you will find a detailed description in the next paragraphs. 

2.2 Directories and Files
The program  ForestSimulator does not need an installation routine. You can copy 
the ForestSimulator folder to a directory of  your choice. Just unpack the file Forest-
Simulator7.zip. In this example the program es unzipped to the directory  \Eigene 
Dateien\ForestSimulator75 . If  you do not have a program for unpacking 
just download the free version of  7-Zip from the internet. 1.

After unpacking you will find the following subdirectories and files (Fig. 1). 

Figure 1: Directories and files of  the program ForestSimulator in Windows Explorer

Table 1 explains the meaning of  the files and subdirectories. If  you are a new to 
this program, you might not want to chance the names and location of  the subdir-
ectories.   

1 http://www.7-zip.org
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Table 1: Meaning of  directories and files of  the program ForestSimulator 

2.3 Installation of  the ForestSimulator under Ubuntu
Running the ForestSimulators under Ubuntu is very similar to Microsoft Windows. 
Most complicated is the installation of  Java3D. This is described in detail. Please 
be sure that you have the administration password. 

Install the Java Runtime Engine (JRE) by the Synaptic package management of  
Ubuntu: System → Systemverwaltung → Synaptic Paketverwaltung.

Install  Java 3D, if  you want to use the 3D-graphics of  the simulator.  First 
download the file  j3d-1_5_2-linux-i586.zip2 and copy it to a new directory. (in this 
example:  /juergen/temp). You can use the file browser to do so. Unpack the 
file  by  highlighting  it  and  choose  Datei  → Mit  Archivmanager öffnen of  the  file 
browser  menu. Press the button [unpack] and entpacken  in the next dialog again. 
You should  now find  in  directory  (example:  /jurgen/temp)  a  sub  directory 
named  j3d-1_5_2-linux-i586.zip.  This sub directory contains the zipped file  j3d-
jre.zip, with the sub directories /ext and /i386 in which you will find the files: 
j3dcore.jar,  j3dutils.jar,  vecmath.jar,  libj3dcore-ogl.so  and  libj3dcore-ogl-cg.  The 
first tree files with the ending *.jar need to copied to the directory jre/lib/ext 
and the last tw0 with the ending .so into the directory jre/lib/i386 of  the valid 
JRE. This action can not be execute by the file manager because you need adminis-
tration rights (Root). But you should use the file browser to localize the sub direct-
ories. This makes the copying easier and better understandable. In this example the 
complete  subdirectory  name  is:  /usr/lib/jvm/java-6-sun-
1.6.0.10/jre/lib/ext. Please notice that you have to use the right Java ver-
sion number. Open a terminal window  Anwendungen → Zubehör → Terminal and 

2 https://java3d.dev.java.net/binary-builds.html
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change the directory of  the terminal window to that one, where you unpacked the 
Java3D files:  
cd home/juergen/temp/j3d-1_5_2-linux-i586

Unzip the the file j3d-jre.zip in the terminal window:
unzip j3d-jre.zip

Copy all files as „root“ (sudo) to the corresponding directories of  your JRE (see 
above). Use the commands:
sudo cp lib/ext/* /usr/lib/jvm/java-6-sun-
1.6.0.10/jre/lib/ext/

sudo cp lib/i386/* /usr/lib/jvm/java-6-sun-
1.6.0.10/jre/lib/i386/

After the first sudo you will be asked for the administration password. If  you do 
not know it, you can not perform this task. 

Unpack the file ForestSimulator7.zip into directory of  your choice and start the 
using the ForestSimulator7 by double click of  file ForestSimulator.jar .

2.4 First use
Start the program by double click of  file  ForestSimulator.jar in Windows Ex-

plorer or by opening the file with Java under Ubuntu. You can change the program 
settings by choosing Einstellungen -> Programm Einstellungen from the menu. You will 
see the following dialog.  (Figure 2):

Figure 2: Dialog of  program settings
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a) Choose your language.

b) Select if  you want to use the 3D or the 2D Graphic. For 3D you will  
Java3D. It requires more memory

c) Select the user directory. It will contain all important information about 
the species and program settings. You can open a directory selecting dialog 
by pressing the search button. 

d) Select the data directory. This directory contains all example stands and all 
your own stand data. 

e) Select the output directory. All output and reports are written to this dir-
ectory. 

f) Choose and XML-File with the simulator settings. The default  Forest-
SimulatorSettings.xml is for the growth model of  north west Ger-
many. 

After you finished a to f, click the button  [ok]. The program will end and you will 
have to start the ForestSimulator again. 

Hint: You have to delete the file ForestSimulator.ini, if  you can not open 
the program and want to start it with it's default settings. 

2.5 Starting ForestSimulators
Start the program by double click of  file  ForestSimulator.jar in Windows Explorer 
or by opening the file with Java under Ubuntu. In the menu under  Help you will 
find a detailed manual to the program. 

If  the program does not start, delete the file  ForestSimulator.ini and check if  the 
Java3D is installed correctly.  You can do so by starting the program in the  2D 
mode. 

If  you want to start the ForestSimulator from the desktop, you have create a 
link. Make sure the working directory is set correctly. 

If  there problems if  you want to simulate stands with numerous trees, because 
the memory of  the java virtual machine is not sufficient, you need to start the pro-
gram by executing the file ForestSimulator.cmd instead of  ForestSimulator.jar. This will 
execute the following command: 
java -Xmx256m -jar ForestSimulator.jar

which increases the memory of  the virtual machine.
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2.6 Update
Unfortunately a good program is never finished. The ForestSimulator7 gets im-
proved from time to time. The program checks at every start if  there is an internet 
connection if  a new simulator version is available. Before you update, make sure 
you save all your data and changes to the default settings.

2.7 Deinstallation
Just delete the complete directory \ForestSimulator. Do not forget to save 
your data if  necessary. 

3 Using the ForestSimulator

3.1 User Interface
The program ForestSimulator is written in Java and it has a graphical interface 
which is shown in figure   3. Using the interface is  intuitive and similiar to the 
standard you already know from other programs. 

The user interface consists of  a main window, in which several other sub win-
dows are integrated. All windows can be modified by the window controls and the 
cursor. You can also move the windows on your screen. If  the main window is 
closed all other windows will be closed and the program stops. The main menu 
and the action buttons are display in the heading of  the main menu.  Choosing 
View  in the main menu you can open other program windows and also reopen 
closed ones.  The top bar of  the window which is active is shown in light blue col-
or. You can switch from window to window by mouse click. That is also the reas-
on, why the menus of  the sub-windows do not react immediately. If  you load a  
stand, all information about it is displayed as shown in figure  3. If   you perform 
an action (e. E. grow or treatment), all windows will be updated.
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Figure 3: Benutzeroberfläche  des  ForestSimulators  (beispielhaft  wurde  hier  der  Bestand  
fibugen2.xml eingeladen)

3.2 stand analysis
This chapter demonstrated the possibilities to use the ForestSimulator to analyze 
and visualize forest stand..

Start  the  ForestSimulator  and  click  in  menu  Stand  → Open  →  Tree-
GrOSS.xml-File. Choose the file fibugen2.xml in the following dialog. After the pro-
gram has read the data, you will find different information in the sub windows. 

.3.2.1 Bestandesinformationen
The window Stand Info shows a table with the main growth and yield information. 
This table is divided by species and also shows the sum of  values. You will always  
find the current status of  the stand in this table. If  there is a thinning the numbers  
will change as soon as the thinning is performed. The meanings and the units of  
the columns are described in  Table 2.

Table 2: Stand Information

Abbreviation Description
Spe. Species

Age Age
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Dgv Mean quadratic diameter [cm]

Hg Height of  mean quadratic diameter [m]

Ddom Mean quadratic diameter of  100 thickest trees/ha of  one species [cm]

Hdom Height of  Ddom [m]

n/ha Number of  trees per hectare [n/ha]

b.area/ha Basal area per hectare [m²/ha]

v/ha Volume (> 7 cm) per hectare [m³/ha]

rem. n/ha Removed number of  trees per hectare [St/ha]

Rem. b./ha Removed basal area per hectare [m²/ha]

Rem. v/ha Removed  volume (> 7cm) per hectare [m³/ha]

mix. %/ Bgrad Percentage of  mixture [%] or degree of  stocking in summation (s. cal-
culation of  area and degree of  stocking.)

You can use   Strg + c  and   Strg + v to copy and paste the content of  the table 
which es highlighted. 
If  you close the window, you can open it by View → Stand Info. 

.3.2.2 Stand map
The stand map shows the distribution of  the tree of  the ground. The species are 
shown in those RGB-colors which are defined in the XML-file with the species set-
tings.  You  can  change  the  settings  with  the  TreeGrOSS  species  manager  (see 
chapter changing the program). If  crop tree are selected, they marked by a red circle. 
The green circle is for temporary crop tree and the yellow color for habitat trees.  
(Figure 4).

If  you  click  at  certain  trees  using  the  left  mouse  button,  the  tree  will  be 
thinned and shown as open squares. You can redo the thinning by clicking on the 
square again. 
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Figure 4: Window of  stand map

Using the menu  Attributes of  the stand map, you choose if  stand information, 
crown size and tree numbers are displayed. At a DBH-Factor of  1 the dbh of  the 
tree will be shown true to scale of  with at least 1 pixel. 

The Graphic sub menu is for redrawing, saving as jpg and for zooming. If  you 
start saving the stand map a file saving dialog will open and the stand map will be 
saved with a higher resolution. Please do not forget to add the ending .jpg to the 
file name. If  you zoom, you have to mark the lower left and the upper right corner 
of  the area. 

The menu left mouse button sets the type of  selection: Thinning and crop 
trees.

.3.2.3 Parallel Projection
The simulator can display the stand in 2D and 3D mode. The visualization mode is 
set in the main menu by Properties → Program settings. If  you want to simulate large 
stands with lots of  trees, it might be necessary that you switch from 3D to 2D 
visualization because 2D uses less computer resources. 

The 3D mode let's you see the stand from every direction even from above. 
You can also walk virtually through the stand. To change the view press the left  
mouse button and move the mouse until the stand is in the desired position. You 
move the stand on the screen by pressing the right mouse button and moving the 
mouse at the time in the four directions. You can zoom by using the mouse wheel. 
Walking through the stand works by the arrow buttons. Please watch out that you 
do not crash into a tree. You will have to walk around. PgUp and PgDown control 
the angle of  your view. So you look up using PgUp. 
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If  you click with the left mouse button on a tree, the attributes of  the tree will 
be shown in a little red window. Please notice: This window is modal, which means 
that you will have to close the window before you can do any other action. If  you 
click on a tree using the right mouse button, you can mark and unmark the tree. A 
red marker is for thinning or harvest, the blue for crop trees, the green for tempor-
ary crop trees, and the yellow for habitat trees. 

The windows Parallel Projection has 11 symbol buttons. The first is to active the 
markers. The second button allows to show the dead trees. The third changes the 
texture of  the tree. The fourth changes the color from green to RGB color. The 
six button add fog and the seventh a grid. The eighth button (camera) allows to  
make picture of  the window which is stored in a jpg file. The ax lets you fell the  
trees to the ground. These will stay in the stand. Button ten is to switch to the 
standard view position. This is important, if  you get „lost“ walking through the 
stand. The last button changes the symbols position. 

For orientation there is a red and white marker stick in the stand, which is loc-
ated in the south west corner. The grid is always orientated in north – south and 
east to west direction.  

The 2D mode of  the window Parallel Projection should also give an impression 
of  the stand. The tree crowns are displayed in the preset RGB-colors. The attrib-
utes menu allows to set if  the living, the dead and the thinned trees will be dis-
played. You can also change the colors of  the sky, the ground and the stand floor. 
The menu Graphic let's you save the stand to a jpg file and allows zooming. The 
jpg file will be saved in the output directory by a standard file name like sv2011.jpg. 
Sv stand for stand view and 2011 for the simulated year. If  you zoom you have to 
mark the lower left and the upper right corner. 

3.3 Reports
You can create several standard reports from the menu Reports. All reports are 
saved to the output directory in form of  HTML and XML files. The reports are 
normally displayed automatically by your browser after you create one. In case the 
browser does not open the reports due to certain settings of  your operating sys-
tem, you can open the reports manually in the browser (File ...).  If  a report is 
called for the second time the old report will be overwritten. In case you want to 
store the reports you need to save these before the next call. 

.3.3.1 Tree values
You can create a list with all tree values by clicking on Reports  → Tree values. The 
list is saved in the file treelist.html. It will be shown in the browser. You can find the 
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in  the  output  directory  (default:  output_standsimulation/treel-
ist.html).

You can also open the file treelist.html with other programs such as Excel, Word 
or OpenOffice. Or you can use the cut and paste functions of  your browser. The 
meanings and the units of  the abbreviations are described in Table 3.

Table 3: Fields of  singel tree list
Abbreviation Meaning
No Tree number
Sp. Species code
Age Age
DBH dbh [cm]
Height Height [m]
c.base Crown base [m]
c.wdith Crown width [m]
cr% Crown percent [%]
h/d h/d-ratio
Vol. Volume inside Bark [m³] (up to 7 cm diameter)
aus -1 = tree is alive, year of  mortality or removal
x relative coordinate x [m]
y relative coordinate y [m]
z relative coordinate z [m]
c66 Position independent competition index c66
c66c Change of  position independent competition index  c66c
c66xy Position dependent competition index c66
c66cxy Change of  position independent competition index c66c
si Site index height at age 100 [m]

.3.3.2 Stand table
The stand values are calculated by Reports  → Stand values. There will be two table in 
the report one for all trees and one for crop trees only. The values are given by 
species. The report gives the numbers from the first to the current simulation step. 
The tables have the character of  a yield table. The column abbreviations are de-
scribed in table 4. 

Table 4: Stand values
Abbreviation Meaning
Year Year of  simulation
Species Species code
Age Age
Dg Quadratic mean diameter [cm]
Hg Height of  Dg [m]
Ddom Diameter of  100 largest trees per hectare [cm]
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Hdom Height of  Ddom [m] 
N/ha Number of  stems per hectare (>=7cm) [n/ha]
Ba/ha Basal area [m²/ha]
V/ha Volume inside Bark [m³/ha] 
rem. N/ha Number of  stems of  removal per hectare (>=7cm) [n/ha]
rem. Ba/ha Basal area of  removal  [m²/ha]
rem. V/ha Volume inside Bark of  removal  [m³/ha] 

.3.3.3 Stand structure
You can generate some information about the stand structure by  Reports →Struc-
ture table. The stand structure is characterized by the vertical and horizontal orggan-
ization of  the trees (see KIMMINS 1987, S.340). The stand structure by means of  sil-
viculture consists of  the spatial arrangement of  the trees, the scrubs and ground 
plants (DENGLER 1992). This structure can be characterized by the tree positions 
(coordinates), the species diversity, the diameter distribution and the vertical struc-
ture in Form of  stand layers. The stand structure is influenced by silviculture. It is  
correlated to the stand stability and gives information about the ecological diversity 
(ALTENKIRCH 1977). 
The ForestSimulator provides the following indicators: 

• number of  species
• Shannon-Index (PIELOU 1966)
• Species profile index (Artenprofil-Index) by Pretzsch (PRETZSCH 1995)
• percentage of  height mingling (ALBERT 1999)
• percentage of  diameter mingling (ALBERT 1999)
• percentage of  species mingling (ALBERT 1999)

.3.3.4 Assortment
The menu Reports →Sorting opens a dialog to evaluate different assortment options 
by reporting the volume of  assortments, the biomass and nutrient export, as well 
as the remaining debris wood. You can include into the evaluation:

• the current stand and the removal of  the same year 
• the removal of  a elapsed year
• the removal of  the entire simulation time

You will find a detailed description in the chapter Assortment of  this manual.
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.3.3.5 Species settings
You can document and review the species settings for the species which are used 
in the simulation by  Reports →List species definition.

.3.3.6 Species code
The  menu  Reports →Species  code  shows  all  species,  which  are  defined  for  your 
ForestSimulator set up. This may be helpful, if  you want to see which species are 
defined for your region and how are the species coded. In the list you will also find 
a link to Wikipedia. You should use Properties →Species manager to define new spe-
cies or changes to existing ones (see separate chapter). 

.3.3.7 Additional graphics
If  you press View →Graphics an additional window will open, which allows to cre-
ate the following graphs:

• Species percentage by crown surface area 
• Diameter distribution
• Diameter distribution of  crop trees
• Height – diameter relation. 

You can not change those graphs. You can only save them as JPEG files.

3.4 Stand treatment and prognosis
This chapter explains the options to manipulate the stand and to mark trees for 
special functionality. Both you can do either interactively or by a rule based dialog. 
The chapter also explains how you can perform a stand prognosis and what you 
have to keep in mind.

.3.4.1 Interactive thinning  
You can interactively mark and thin trees in the windows Stand map. 
In the Stand map window you just point at the tree with the mouse and press the left  
mouse button. You can switch in the menu of  this window whether you want to thin 
or to mark trees. You just point at the trees with your mouse an press the left  
mouse button. The thinned trees will be shown as open squares. Crop trees are 
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marked by a red ring. If  the function Stand information is activated you can see for 
instance how much trees you have thinned.  It  is  also possible to reselect  trees 
thinned trees.  
You can do interactive stand treatment and marking of  trees in addition and in 
combination with the automatic rule based stand treatment.

.3.4.2 Automatic rule based stand treatment
You can set you stand treatment scenario in the window Simulation Settings.

Figure 5: Dialog to set treatment scenarios

In the first dark grey line of  the dialog you can make some basic settings for the 
simulation. The time set the duration of  the simulation. If  the value is greater than 
5 years automatically so many 5-year simulations steps will be executed until the 
wanted time is reached or exceeded. Remaining years or times below 5 years are  
simulated by one 5-year time step which is linear interpolated to the given time 
length (see chapter prognosis). The check boxes  random effects,  ingrowth model, and 
risk model determine if  these are included in the simulation. By pressing the  start  
button you execute the simulation with the set stand treatment. 

In the next row you can define if  the simulator should establish skid traids and 
you can set the width and the distance of  skid trails. The skid trail function is only ex-
ecute once, when stand height exceeds the height for the first thinning.

The options for thinnings are set in the next row. There three  thinning types: 
single tree selection, thinning from above, and thinning from below. The  thinning  
intensity can be set by the next check box. The moderate thinning is oriented on the 
recommendations given by the Northwest German Forest Research Station. The 
actual basal to which a stand will be thinned, is determined by the maximum density  
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function and the given moderate thinning factor. Both can be altered in the species manager  
dialog. You can fix the minimum and maximum thinning volume in order to limit 
thinnings.  By checking the box release crop trees only you will just thin trees, which 
are in competition to crop trees.

The harvesting method is given in the line. You can select the harvesting methods: 
target diameter,  shelter wood, and clear cut. The last two methods are only executed if  
50% of  the basal of  the trees have reached the target diameter. You can also limit 
the  minimum and maximum harvesting volume. If  you have chosen target diameter har-
vesting you can set the criterion for a final removal of  all remaining over story 
trees in the field final cut at B° a degree of  stocking. If  you selected shelterwood the 
stand will be cut by a given regeneration process sequence. The sequence “0.7; 0.5; 0.3;  
0.0;“ means, that  the degree of  stocking will be lowered to 0.7 in the first time 
step, 0.5 in the second, 0.3 in the third, and all remaining over story will be out in 
the fourth time step. Each degree of  stocking in that sequence should be separated 
by a semicolon (“;”). There should be also a semicolon at the end. If  you chose 
clear cut all trees will be removed.

In the line  protection you can set the  number of  habitat trees per hectare and the 
group of  trees where the habitat trees will be selected from. Habitat trees are selec-
ted from the pool of  trees which have exceeded the target diameter limit by 80%. 
If  you check the box minorities at least one crop tree per species will be selected to 
ensure that rare species get priority. Additionally you can set a minimum coverage and 
protect all tress with dbh greater or equal a certain value. Notice that the protection 
settings are given a higher priority than the thinning and harvesting rules. So for in-
stance a clear cut might be not possible because of  the protection settings. 

The last line are the rules for planting. First  decide if  you want to activate 
planting. Define if  the under story should be removed before planting. The plant-
ing is executed when the degree of  coverage of  the over story trees is below the 
level you set at planting at B°. In the last text field of  that row you tell the system 
hat to plant. The text “511[0.5];211[0.5];” means that species 511 and 211 will be 
planted, each with a coverage of  50%. The ForestSimulator does not have a real 
regeneration routine, therefore the trees planted are only placeholders. Each place-
holder covers an area of  5 m² ground which is about the size of  the trees when in-
growth occurs (7cm). The height growth of  the placeholders is oriented on the site 
index. The placeholders die in the simulation of  the competition index get to high. 
By a given h/d ratio the diameter of  the placeholders is calculated from the height.  
If  it exceeds 7 cm in dbh a new tree of  the placeholder's species is established. 

 
In the table species settings you can adjust the settings for the treat of  each spe-

cies. The column  th.height[m] determines at what height the first  thinning is ex-
ecuted. If  the average height of  a species is below that given height, there will be 
no thinning. The column target diameter [cm] determines the size of  crop trees for 
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harvesting. The number of  crop trees [ha] is important for the thinning and the fu-
ture species composition of  the stand. The default values of  that column are cal-
culated by the number of  crop trees which will fit on the site without crown con-
tact at given target diameter. You can of  course change the default settings. The 
column mix% determines how much of  the stand should be covered by one spe-
cies. These numbers are used to calculate the default number of  crop trees. You 
can best change the species composition by altering the number of  crop trees.

The simulation process is started when you hit the button start simulation. If  
you press the ax symbol in the top menu or choose Action → treatment the settings 
of  the window simulation settings will be read and a single treatment will be con-
ducted. 

.3.4.3 Prognosis
The major function of  the ForestSimulator is to stand prognosis. Each time 

setp is a five year period. You can start a prognosis by the menu action → grow or by 
by pressing the tree symbol. Please notice, that the longer you grow a stand the less 
precise the prediction will be. Generally, the length of  the simulation should not 
exceed 30 to 40 years. The errors will be also higher if  you simulate very extrem 
stand situations.

For the 5-year growing period you can set if  random effects, ingrowth, and a 
risk model should be active. The random effects will add a random error compon-
ent to the diameter and height growth. That way trees with the same attributes will 
grow differently. The ingrowth model will predict ingrowing trees. The risk model  
add another component of  random mortality. The probabilities are set to the aver-
age drop out values from the survey of  the states Hessen, Lower Saxony and Sach-
sen-Anhalt. 

• The growth action will call the following procedures:
• check for age dependent mortality
• check for risk mortality (if  activated)
• check for density dependent mortality
• calculate diameter and height growth
• adjust the crown width and crown base
• establish ingrowth (if  activated)
• increase the age
• update all windows in the simulator 
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Every time you start the single growing step a copy of  the stand data will be 
saved in the treegross xml format to the directory data-simulation. The copy's file  
name consists of  the name and the year (example: Stand_2020.xml). You can use 
the copies (Stand → open → TreeGrOSS.xml-File) if  you want to go back in simula-
tion or branch off  a different treatment scenario. 

The stand development is also saved by the simulated and can be displayed by 
Reports → Stand table .    

3.5 Assortment

.3.5.1 Introduction
The menu allows  Reports  → Sorting to analyze different utilization strategies 

with respect to the volume of  assortment, remaining debris wood and nutrient bal-
ance. The report can focuse on the harvested trees of  a year, the remaining and the 
removed trees of  the current year, and remaining stand and all removed trees in 
the simulation. The calculation of  the assortments is based on the taper functions 
of  SCHMIDT (2001). With the help of  these functions it is possible to estimate the 
diameter of  a tree at a given height. The functions for hardwoods should be only 
used up to crown base. The taper functions by SCHMIDT (2001) are also dependent 
of  the h/d-ratio. The bark thickness is calculated by the functions of  ALTHERR et al. 
(1978).

In the program it is possible to define assortments very flexible for one or sev-
eral species. In the context of  the program an assortment can be understood as 
pieces of  the tree trunc with certain attributes. Therefore pieces which should re-
main in the forest because of  decay or by other reasons need also to be defined 
like an assortment. The definition is given by the following parameters:  

• name of  assortment

• Species code (or species code from to)

• minimum and maximum middle diameter [cm]

• minimum and maximum top diameter [cm]

• minimum and maximum length [m]

• assortment is removed or stays in the forest

• tolerance for sale

• assortment can occur only below crown base

• assortment can occur in all trees or only in crop trees
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• priority

• value

• amount of  trees the assortment will occur in

• assortment can occur multiple or only one time in a tree trunc

The sorting is done in a simple way. The program tries to cut the assortment 
with the highest priority as long as possible starting at the base of  the tree. If  that  
assortment does not occur in that tree anymore or the other restrictions prevent 
the program from doing so the assortment with the next higher priority will come 
into consideration. This process is continued until all defined assortments are eval-
uated. 

.3.5.2 Calculate assortments
Choosing Reports →Sorting in the main menu opens the Assortment Dialog (fig. 

 6).

Figure 6: Assortment Dialog

In the top row of  the Sorting Dialog you can set in the text field behind choose & set  
assortments  for  years the time frame for the calculation.  The default  is  all,  which 
means all cut and remaining trees will be evaluated. If  you enter a year (example: 
2010) only the trees harvested in the year 2010 are part of  the calculation. In the 
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next text field after fell.cut [m] you can define the height at which the trees are usu-
ally felled. All volume below that height will be accounted to the debris wood. 

The sorting dialog can be also used to estimate the volume, the biomass and 
the nutrient elements of  x-wood and debris wood. To do so you have to define a 
special assortment with a high priority.  

You can alter, define new and delete assortments using this dialog. The defined 
and useable assortments are shown in left box. If  you click on a name in that box 
the attributes of  the assortments will be displayed. To alter you can change the text 
fields and press the button save or add the settings as a new assortment. Do not for-
get to change the name. A marked assortment can be delete using the delete button. 
Hint: if  you make changes you should better close the dialog each time. 

In order to calculate the assortments of  a stand, you first choose the assort-
ments you want to consider. Mark the assortments in the box with the left mouse 
button and choose additional ones by holding down the  Strg  or Ctr button. After 
you have marked the assortments just press the lower button for calculation. Please 
be patient if  you choose several assortments and if  you have a stand with numer-
ous  trees.  The  sortet  trees  will  be  saved  to  the  file  sortierung.xml  into  the 
output_standsimulation  directory.  The  file  will  be  automatically  displayed  by  your 
browser with the help of  a style sheet treegrosslogging.xsl. In case the browser does 
not show the file you will have to open it manually. The file contains a report with 
several tables:

Table 1: List of  the used assortments

Table 2: Volume by species

Table 3: Biomass by species

Table 4: Calcium by species

Table 5: Magnesium by species

Table 6: Potassium by species

Table 7: List of  all stem pieces

3.6 Using of  own stand data
In this chapter you will learn how to generate stands and how you can use your 

own data 
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.3.6.1 Generating new stands
If  you have a special question to forest growth and you do not have any data, 

you can generate a stand, which should fit to your question. This might help to get  
a better understand the problem. 

You can generate a stand using the main menu Stand → new . Add a name, the 
size [ha] and choose the form (square or circle) of  your model stand. If  you press 
the button create. An empty stand with no trees will appear. The size of  the simu-
lation plot should fit your question. If  you want to analyze a very young stand with 
lots of  trees you should choose a size 0.1 to 0.2 ha so that you can save computing 
time and memory. Is your question geared towards older stands, then it might be 
better if  you chose a size of  0.5 to 1 ha. If  you need to simulate large stands with 
many trees you can switch the visualization to 2D that also saves memory and 
computing time.

 You can trees to the stand in three different ways. The first option is to gener-
ate a distribution, which is created by some average plot information like species, 
age, mean basal area diameter (dg), the height of  dg, maximum diameter and the 
wanted basal area ( 7a). The information for site index (height at age 100) is op-
tional and if  you do not know it add -9. When you press start creating the trees will 
be places on random coordinates, which are chosen in a way that the crowns will not 
overlap if  possible.  Raster coordinates plat the trees in rows and columns. If  you 
choose under Mischung Trupp or Horst the trees will be clustered. You can also ac-
tivate the option skid trails so that those trails will be without trees. -  The second 
options is to generate n trees with same attributes like species, age, diameter, height 
and site index (optional)( 7b). The coordinates are assigned as described before. - 
And in the third option you can create a regeneration layer. Just chose the species  
and add the age the height and the degree of  coverage( 7c). The site index is op-
tional. Since there is only an ingrowth model the regeneration layer consists of  5m² 
regeneration placeholders.

a) b) c)

Figure 7: Dialog add trees: a) generate diameter distribution; b) generate single trees; c) generate re-
genration layer

If  you want to create a multistory or mixed stand, you have to use the add tree dia-
log several times after each other. It is recommended to start with the larger trees.  
The dialog can be also used to “plant” or add new trees at any point in the simula-
tion.
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.3.6.2 Edit stand data
You can edit the stand data directly in the ForestSimulator using Edit → Stand  

data. The dialog shows the data of  the current stand (fig. 8). If  you want to change 
your changes you have to press the button accept changes before you close the win-
dow. You copy and paste from the dialog window using  Strg + c and  Strg + v the 
commands. You can also use the dialog to create stands with the editor dialog. For 
this task first generate a new stand with the correct size and form. Next add only 
one tree to that stand, so that you have an example how your data should look. 
Save that stand and open it with Edit → Stand. The buttons add cornerpoint and add 
lines let you add empty rows to the tables. Next add the data with paste and copy to 
the tables. If  you accept the changes empty rows of  the tables will be ignored.

Figure 8: TreeGrOSS editor

If  you have polar coordinates, you can convert them to xy coordinates (button 
xy2polar resp.  polar2xy.  All coordinates are converted based on the corner point 
polygon. The coordinates are shifted so that all of  them have positive values.  If  
you save the data all coordinates need to be xy-coordinates.

Some times the 3D graph will not show up after using the TreeGrOSS Editor.  
In this case just move the window with the graph a little and it gets refreshed.

.3.6.3 TreeGrOSS – data format

For data in- and output all stand data needs to be in the TreeGrOSS Format, 
which is  defined as an xml data file.  XML (Extensible  Markup Language)  is  a 
format which allows to describe the data by tags. The tags are similar to HTML 
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tags and are marked by <>. The names of  the tags can be freely chosen. Table 5 
shows the structure and the tags of  a treegross.xml file. An xml file can hold also 
structured data. You can print and display xml-data with the help of  style sheets in 
different ways. For the display of  data in the TreeGrOSS Format there is an tree-
gross.xsl style sheet.

Table5: Structure and tags of  a treegross.xml File
<Tag> <Tag> Discription (data type)
Stand Stand information

ID Stand ID  (character)
Kennung Any other name (character)
Allgemeines Any text (character)
Flaechengroesse_m2 Stand size [m²] (decimal)
HauptbaumArtCodeStd Standard code of  main species (integer)
HauptbaumArtCodeLokal lokale code of  main species (integer)
AufnahmeJahr Year of  survey (integer)
AufnahmeMonat Month of  survey (integer)
DatenHerkunft Data origin (character)
Standort Site name  (character)
Hochwert_m Gauss-Krüger northing of  stand (decimal)
Rechtswert_m Gauss-Krüger easting of  stand (decimal)
Hoehe_uNN_m Height above sea level [m] (decimal)
Exposition_Gon Exposition of  stand [Gon] (integer)
Hangneigung_Prozent Gradient [%] (integer)
Wuchsgebiet Name of  growth region  (character)
Wuchsbezirk Name of  growth district (character)
Standortskennziffer Site code (character)

Baumar-
tencode

Species information

Code Code number (integer)
deutscherName German species name (character)
lateinischerName Latin species name (character)

Eckpunkt
Nr Number of  corner point (character)
RelativeXKoordinate_m relative x-coordinate of  corner point [m] 

(decimal)
RelativeYKoordinate_m relative a-coordinate of  corner point [m] 

(decimal)
RelativeBodenhoehe_m relative z-coordinate (height) of  corner 

point [m] (decimal)

Baum Tree information
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Nr number (character)
Kennung Height of  diameter measurement (integer)
BaumartcodeStd Species code (integer)
BaumartcodeLokal Local species code (integer)
Alter_Jahr Age [years] (integer)
BHD_mR_cm Dbh inside bark [cm] (decimal)
Hoehe_m height [m] (decimal)
Kronenansatz_m Crown base [m] (decimal)
MittlererKronenDurchmes-
ser_m

Mean crown diameter [m] (decimal)

SiteIndex_m Height at age 100 [m] (decimal)
RelativeXKoordinate_m Relative x-coordinate of  tree [m] (decimal)
RelativeYKoordinate_m Relative y-coordinate of  tree [m] (decimal)
RelativeBodenhoehe_m Relative z-coordinate of  tree [m] (decimal)
Lebend Tree alive (true/false)
Entnommen Tree removed (true/false)
AusscheideMonat Month of  removeal (integer)
AusscheideJahr Year of  removal , lebend = -1 (integer)
AusscheideGrund Reason for removal (integer)
ZBaum Crop tree (true/false)
Zbaumtemporaer Temporary crop tree (true/false)
HabitatBaum Habitat tree (true/false)
KraftscheKlasse Kraft'sche tree class (integer)
Schicht Stand layer (integer)
Flächenfaktor Size factor normal 1.0 (decimal)
Volumen_cbm Volume inside bark  m³ (decimal)
VolumenTotholz_cbm Volume, if  debris wood m³ (decimal)
Bemerkung Remarks (character)

3.7 Add additional trees to stand
This was already explained in the Chapter „Generating new stands“.

3.8 Special functions

.3.8.1 Using the results in other programs 
This should give you just some ideas, how you can integrate the results from 

the simulator into other programs.

XML- und HTML- files
All results are displayed and stored as xml or hmtl files. You can view both type in 
your browser, however the xml-files might need a style sheet. You can copy and 
paste the information from the browser into other programs like spreadsheets (MS 
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Excel or  OpenOffice Calc). It is also possible to read in the HMTL files into those 
programs directly. The xml-files you might need to save to HTML before doing so.

Using the graphical information 
Most graphical information is stored in jpg files. You can open these with any 

graphical program. In addition you can save a screen shot and paste that into a 
graphical software.

3.9 Adjust the simulator 
There are two important program controlling files. The first file ForestSimulator.ini  
controls the general setup and was already explained in the chapter installation. 
The second file  ForestSimulatorSettings.xml  (default name) controls the ForestSimu-
lator and holds most of  the equations. You can best edit this file Properties → Spe-
cies Manager choosing in the menu. The dialog is displayed for the species oak of  
the model region Northwest Germany (fig. 9).

Figure 9: Dialog of  Species Managers

In this dialog you will find on the left the species with their abbreviation. The 
default setting is the model for Northwest Germany. If  you click on one of  the 
short  species names, you can see all  the properties of  that species in the main 
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table. You can of  course change the text in the table. If  you that your changes shall 
be come permanent, you first leave the table cell you changes by clicking into an-
other one, then hit the button save and finally press save settings to file. You can add 
new and also delete species. In table 

 In table 6 you find an example of  the settings for the species Fagus silvatica.

Table 6: XML-file , species settings for Fagus silvatica

Tag 
<SpeciesDefinition
>

Type Pack-
age

Setting for beech (Northwest Germany)

Baumarten Code I B 211

Kurzname A B Bu

Name A B Buche

lateinisch A B Fagus silvatica http://de.wikipedia.org/wiki/Rotbuche

Interner Code I 211

Gruppen Code I 200

Einstellungen wie 
Code

I B 211

Height Curve I B 1

Uniform Height 
Curve

AF B 1.3+(sp.hg-1.3)*exp(0.20213328*(1.0-
(sp.dg/t.d)))*exp(5.64023296*((1.0/sp.dg)-(1.0/t.d)))

Height Variation AF S 1.1217150+0.2203473*ln(sp.BHD_STD)

Diameter 
Distribution

AF b (-4.282+1.132*sp.dg)*(((6.9/(-
4.282+1.132*sp.dg))^(4.518+0.317*sp.dg-
0.200*dmax))-ln(1.0-random))^(1.0/(4.518+0.317*sp.d-
g-0.200*dmax))

Volume Function 
o.B.

AF B 3.141592*t.h*(t.d/200)^2*(0.4039+0.0017335*t.h+1.12
67/t.h-118.188/(t.d*t.d*t.d)+0.0000042*t.d*t.d)

Stem Volume 
Function

af s

Crown width AF B (2.0837+0.15*t.d)*(1.0-exp(-
exp(ln(t.d/5.7292)*1.3341)))

Crown base AF B t.h*(1.0-exp(-abs((0.25704+0.11819*t.h/t.d-
0.002065*t.d+0.13831*ln(sp.h100)))))

Crown type I S 0

Site index AF B (sp.h100+75.65900-23.19200*ln(t.age)
+1.46800*((ln(t.age))^2.0))/
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(0.00000+0.21520*ln(t.age))

Site index height AF B -75.65900+23.19200*ln(25.0)-
1.46800*(ln(25.0)^2)+0.0*t.si+0.21520*t.si*ln(25.0)

Potential height 
increment

AF B ((-75.65900+23.19200*ln(t.age+5)-
1.46800*((ln(t.age+5))^2.0)+0.21520*t.si*(ln(t.age+5)))
-(-75.65900+23.19200*ln(t.age)-
1.46800*((ln(t.age))^2.0)+0.21520*t.si*(ln(t.age))))

Height increment AF B 0.00159*(t.hinc^1.9086)

Height increment 
error

D B 0.082

Quadratic diameter 
increment

AF B exp(-7.393+1.375*ln(3.14159265359*(t.cw/2.0)/
(6.0*(t.h-t.cb)^2)*((4.0*(t.h-t.cb)^2 +(t.cw/2)^2)^1.5 - 
(t.cw/2)^3))-0.791*ln(t.age)-
0.793*t.c66xy+0.809*t.c66cxy-0.0*ln(5.0))

Diameter Increment 
Error

D B 0.762

Maximum density AF B 0.0001*3.141592/
(16*0.00000010829*8.3652*(t.h^(1.5374-1.7365)))

Maximum age I B 300

Plugin Ingrowth a b Ingrowth2

Decay af b 1.0-((sp.year-t.out-5.0)/30.0)

Target diameter D T 65.0

Height of first 
thinning

D T 12.0

Moderate Thinning 
Factor

A(D) T 12.0;0.7;22.0;22.0;0.65;28.0;28.0;0.75;100.0

Color A(I) S 199;83;28

Plugin Competition A B Competition

Plugin 
TaperFunction

a b TaperFunctionBySchmidt

Grobwurzelbiomass
e Funktion

af s 0

Kleinwurzelbiomass
e Funktion

af s 0

Feinwurzelbiomasse 
Funktion

af s 0

Gesamtwurzelbioma
see Funktion

af s 0

Type: I = integer; D = double, A = character, AF = function as string
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TreeGrOSS Package: B = treegross.base, T = treegross.treatment, S = treegross.standsimulation; 
Capital letter = required input, small letter = optional 

All information in  Table 6 that is marked by „AF“ resp. „af“ contains equa-
tions. These character strings are evaluated by a Java Equation Parser3 (JEP). The 
JEP requires some declaration for the variables used. In Table 7 the main functions 
and variables are listed.

Table 7: Declaration and Variables for the Java Equation Parser

declaration Variable declaraction Variable

t.d Tree diameter [cm] sp.dg Mean Quadratdiameter (dg) of 
species [cm] 

t.h Tree height [m] sp.hg Height of dg of species [m]

t.age Tree age [years] sp.h100 Top height of species [m]

t.c66xy Tree competition sp.year Year of simulation

t.c66cyx Tree competition 
change

sp.BHD_ST
D

Standarddeviation of diameter 
of species [cm]

t.out Tree removal year abs() Absolut

t.si Tree site index exp() Exponent

t.ihpot Tree potential height 
increment [m]

ln() Natural log.

t.hinc Tree height increment 
[m]

random Random number 0 -1

If  there is no information for a  specific  species and you want that species 
treated like another species, you only have to complete the first 6 lines. The species 
in the field will  refer to that species and it's information is copied for all other 
fields where there is no input or the field is blank. 

Attention: Chan

ges to the species settings may have significant impact on the simulation.

3.10 Convert BWINPro6.2 files to XML
In the help menu you find a procedure which may help to convert data from 

the old BWINPro 6.2 version to the new TreeGrOSS format (BWIN62 → XML). 
It is important that all species which are in the old format are already defined in  
the simulator.

3 Thanks to the open source code and version of  JEP (http://www.singularsys.com/jep/)
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5 Appendix

5.1 Equations and Settings for Northwest Germany

Tabelle 8: Species code
Code Kurz Name lat. Name Einstellung wie
110 Ei Eiche Quercus 110
111 SEi Stieleiche Quercus robur 110
112 TEi Traubeneiche Quercus petraea 110
113 REi Roteiche Quercus rubra 113
114 ZEi Zerreiche Quercus cerris 110
115 SuEi Sumpfeiche Quercus cerris 110
211 Bu Buche Fagus silvatica 211
221 Hbu Hainbuche Carpinus betulus 211
311 Es Esche Fraxinus excelsior 311
321 BAh Bergahorn Acer pseudoplatanus 321
322 SAh Spitzahorn Acer platanoides 321
323 FAh Feldahorn Acer campestre 321
331 BRue Bergulme Ulmus glabra 211
332 FlaR Flatterulme Ulmus laevis 211
333 FRue Feldulme Ulmus minor 211
341 SLi Sommerlinde Tilia platyphyllos 342
342 WLi Winterlinde Tilia cordata 211
351 Rob Robinie Robinia pseudoacacia 211
352 Kast Kastanie Castanea sativa 211
353 Nuss Nussbaum Juglans regia 211
354 Kir Kirsche Prunus avium 211
355 Apf Wildapfel Malus silvestris 211
356 Bir Wildbirne Pyrus pyraster 211
357 Els Elsbeere Sorbus torminalis 357
358 Spei Speierling Sorbus domestica 357
359 Mehl Mehlbeere Sorbus intermedia 357
361 Tul Tulpenbaum Liriodendron tulipifera 321
362 Hi Hickory Carya alba 321
363 Pla Platane Platanus acerifolia 321
365 Zwe Wildzwetschge Prunus domestica 357
372 Faulb Faulbaum Faulbaum 357

ForestSimulator BWINPro 7.6 – Englisch Manual – Version April 2011



Appendix
39

Code Kurz Name lat. Name Einstellung wie
375 Has Hasel Corylus avellana 357
380 Pfaff Pfaffenhütchen Euonymus europaeus 357
386 Ilex Stechpalme Ilex aquifolium 357
410 Bi Birke Betula 412
411 SBi Sandbirke Betula pendula 412
412 MBi Moorbirke Betula pubescens 412
413 JBi Japanische Birke Betula 412
414 HyBi Hybrid Birke Betula 412
421 REr Roterle (Schwarzerle) Alnus glutinosa 421
422 WEr Weißerle (Grauerle) Alnus incana 421
423 GEr Grünerle Alnus incana 421
430 Pa Pappel Populus 211
431 As Espe o. Zitterpappel Populus tremula 110
432 SPa Schwarzpappel Populus nigra 110
433 GPa Graupappel Populus canescens 110
434 BPa Balsampappel Populus balsamifera 110
441 Wei Weide Salix 110
442 RKast Rosskastanie Aesculus hippocastanum 321
451 Ebs Eberesche Sorbus aucuparia 211
452 TKir amerik. Traubenkirsche Prunus serotina 221
511 Fi Fichte Picea abies 511
512 SFi Sitkafichte Picea sitchensis 511
513 OFi Omorikafichte Picea omorika 511
514 SteFi Stechfichte Picea pungens 511
515 SwFi Schwarzfichte Picea mariana 511
516 SaFi Sachalinfichte Picea glehni 511
517 YeFi Ajanfichte Picea jezoensis 511
521 Ta Weisstanne Abies alba 511
522 NTa Nordmannstanne Abies nordmanniana 511
523 KTa Küstentanne Abies grandis 511
524 KolTa Koloradotanne Abies concolor 511
525 ETa Edeltanne Abies procera 511
527 LTa Sierra-Tanne Abies concolor var.lowiana 511
528 VTa Veitchs-Tanne Abies veitchii 511
529 PTa Purpurtanne Abies amabilis 511
541 Ts Hemlock Picea abies 541
542 Th Lebensbaum Thuja plicata 711
611 Dgl Douglasie Pseudosuga menziezii 611
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Code Kurz Name lat. Name Einstellung wie
711 Ki Kiefer Pinus Silvestris 711
712 SKi Schwarzkiefer Pinus nigra 711
731 Stro Strobus Pinus strobus 711
811 ELae Europäische Lärche Larix deciduas 811
812 JLae Japanische Lärche Larix kaempferi 811
999 Grass Grass Grassverdämmung 999

Voll
parametri-

siert

Weitgehend
parametrisiert

Teilweise
parametrisiert

Nicht
parametrisiert

Tabelle 9: Baumart 110 – Eiche (Quercus)
Durchmessergenerierung [cm] t.d = (-1.937+1.082*sp.dg)*(((6.9/(-

1.937+1.082*sp.dg))^(4.669+0.366*sp.dg-0.234*dmax))-ln(1.0-
random))^(1.0/(4.669+0.366*sp.dg-0.234*dmax)) /* Eiche 
(NAGEL u. BIGING 1995) */

Einheitshöhenkurve [m] t.h = 1.3+(sp.hg-1.3)*exp(0.14657227*(1.0-
(sp.dg/t.d)))*exp(3.78686023*((1.0/sp.dg)-(1.0/t.d))) /* Eiche 
(NAGEL 1999)*/

Höhenvariabilität [m] t.hv = -0.1944676+0.3535610*ln(sp.dg) /* Eiche (ALBERT 
2000)*/

Volumenfunktion [m³] t.v = 3.141592*t.h*(t.d/200)^2*(0.4786-(1.011176/t.d)
+(2.10428/t.h)-(203.1997/(t.d*t.h*t.h))) /*Eiche Derbholz 
(BERGEL 1974) */

Kronenbreite [m] t.cw = (2.6618+0.1152*t.d)*(1.0-exp(-
exp(ln(t.d/8.3381)*1.4083))) /* Eiche (DÖBBELER ET. AL. 
2001) */ 

Kronenansatz [m] t.cb = t.h*(1.0-exp(-abs((-0.5268+0.2287*t.h/t.d-
0.00453*t.d+0.4712*ln(sp.h100))))) /* Eiche (DÖBBELER ET. 
AL. 2001) */ 

Kronentype in Grafik: Kronentyp= 0 (0=Laubholz, 1= Nadelholz) 
Bonität (Höhe im Alter 100) 
[m]

t.si = sp.h100/(1.2164*(1.0-exp(-0.0194*t.age))^1.1344) /* Eiche 
(DÖBBELER ET. AL. 2001) */ 

Höhe entsprechend der Bonität 
[m] 

Höhe = 1.2164*t.si*(1.0-exp(-0.0194*t.age))^1.1344 /* Eiche 
(DÖBBELER ET. AL. 2001) */ 

Potentieller Höhenzuwachs [m] ihpot = ((1.2164*t.si*(1.0-exp(-0.0194*(t.age+5.0)))^1.1344)-
(1.2164*t.si*(1.0-exp(-0.0194*t.age))^1.1344)) /* Eiche 
(DÖBBELER ET. AL. 2001) */

Höhenzuwachs [m] t.hinc = t.h*((((1.2164*t.si*(1.0-exp(-
0.0194*(t.age+5.0)))^1.1344)-(1.2164*t.si*(1.0-exp(-
0.0194*t.age))^1.1344))/sp.h100)+(0.01676*(t.hinc^1.3349))) /* 
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Eiche (DÖBBELER ET. AL. 2001) */ 

Höhenzuwachsstreuung [m] herror = 0.082
Grundflächenzuwachs [cm²] t.dinc = exp(-6.5350+1.3260*ln((3.141593*(t.cw/2.0)/(6.0*(t.h-

t.cb)^2.0))*(((4.0*(t.h-t.cb)^2.0+(t.cw/2.0)^2.0)^1.5)-
(t.cw/2.0)^3.0))-0.8437*ln(t.age)-
0.9373*t.c66xy+0.1239*t.c66cxy-0.1263*ln(5.0)) /* Eiche 
(DÖBBELER ET. AL. 2001) */

Durchmesserzuwachsstreuung 
[cm]

herror = 0.617

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = 0.0001*3.141592/
(16*0.000002807*0.5814*(t.h^(0.9082-1.1830))) /* Eiche 
Nordwest (DÖBBELER 2004) */

Maximales Alter [Jahre] MaxAlter = 600
Totholzzersetzung (Faktor) 1.0-((sp.year-t.out-5.0)/30.0)
Zielstärkendurchmesser [cm] 80.0
Höhe der 1. Durchforstung [m] 14.0
Mäßige Durchforstung 
[m;NB°]

14.0;0.75;18.0;18.0;0.80;24.0;24.0;0.85;100.0

Farbe (RGB) 255;255;51
Plugin: Einwuchs Ingrowth2
Plugin: Konkurrenzindex Competition
Plugin: Schaftformfunktion TaperFunctionBySchmidt
Volumenfunktion Schaftholz 
[m³]

Tabelle 10: Baumart 211 – Buche (Fagus silvatica)
Durchmessergenerierung 
[cm]

t.d = (-4.282+1.132*sp.dg)*(((6.9/(-
4.282+1.132*sp.dg))^(4.518+0.317*sp.dg-0.200*dmax))-ln(1.0-
random))^(1.0/(4.518+0.317*sp.dg-0.200*dmax)) /* Buche (NAGEL u. 
BIGING 1995) */

Einheitshöhenkurve [m] t.h = 1.3+(sp.hg-1.3)*exp(0.20213328*(1.0-
(sp.dg/t.d)))*exp(5.64023296*((1.0/sp.dg)-(1.0/t.d))) /*Buche (NAGEL 
1999) */

Höhenvariabilität [m] t.hv = 1.1217150+0.2203473*ln(sp.BHD_STD) /* Buche (ALBERT 
2000)*/

Volumenfunktion [m³] t.v = 3.141592*t.h*(t.d/200)^2*(0.4039+0.0017335*t.h+1.1267/t.h-
118.188/(t.d*t.d*t.d)+0.0000042*t.d*t.d) /*Buche Derbholz (BERGEL 
1973) */

Kronenbreite [m] t.cw = (2.0837+0.15*t.d)*(1.0-exp(-exp(ln(t.d/5.7292)*1.3341))) /* 
Buche (DÖBBELER ET. AL. 2001) */ 
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Kronenansatz [m] t.cb = t.h*(1.0-exp(-abs((0.25704+0.11819*t.h/t.d-
0.002065*t.d+0.13831*ln(sp.h100))))) /* Buche (DÖBBELER ET. AL. 
2001) */ 

Kronentype in Grafik: Kronentyp= 0 (0=Laubholz, 1= Nadelholz) 
Bonität (Höhe im Alter 
100) [m]

t.si = (sp.h100+75.65900-23.19200*ln(t.age)
+1.46800*((ln(t.age))^2.0))/(0.00000+0.21520*ln(t.age)) /* Buche 
(NAGEL 1999) */ 

Höhe entsprechend der 
Bonität [m] 

Höhe = -75.65900+23.19200*ln(t.age)-
1.46800*(ln(t.age)^2)+0.0*t.si+0.21520*t.si*ln(t.age) /* Buche 
(NAGEL 1999) */ 

Potentieller 
Höhenzuwachs [m]

ihpot = ((-75.65900+23.19200*ln(t.age+5)-
1.46800*((ln(t.age+5))^2.0)+0.21520*t.si*(ln(t.age+5)))-(-
75.65900+23.19200*ln(t.age)-
1.46800*((ln(t.age))^2.0)+0.21520*t.si*(ln(t.age)))) /* Buche (NAGEL 
1999) */ 

Höhenzuwachs [m] t.hinc = t.h*((((-75.65900+23.19200*ln(t.age+5)-
1.46800*((ln(t.age+5))^2.0)+0.21520*t.si*(ln(t.age+5)))-(-
75.65900+23.19200*ln(t.age)-
1.46800*((ln(t.age))^2.0)+0.21520*t.si*(ln(t.age))))/sp.h100)+(0.00159
*(t.hinc^1.9086))) /* Buche (DÖBBELER ET. AL. 2001) */ 

Höhenzuwachsstreuung 
[m]

herror = 0.082

Grundflächenzuwachs 
[cm²]

t.dinc = exp(-7.393+1.375*ln(3.14159265359*(t.cw/2.0)/(6.0*(t.h-
t.cb)^2)*((4.0*(t.h-t.cb)^2 +(t.cw/2)^2)^1.5 - (t.cw/2)^3))-
0.791*ln(t.age)-0.793*t.c66xy+0.809*t.c66cxy-0.0*ln(5.0)) /* Buche 
(DÖBBELER ET. AL. 2001) */ 

Durchmesserzuwachsstre
uung [cm]

herror = 0.762

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = 0.0001*3.141592/
(16*0.00000010829*8.3652*(t.h^(1.5374-1.7365))) /* Buche Nordwest 
(DÖBBELER 2004) */ 

Maximales Alter [Jahre] MaxAlter = 300
Totholzzersetzung 
(Faktor)

(1.0-(((1.0-exp(-0.0658*(t.age)))^2.2529 ))) /* Buche (MEYER 2009) 
*/ 

Zielstärkendurchmesser 
[cm]

60.0

Höhe der 1. 
Durchforstung [m]

12.0

Mäßige Durchforstung 
[m;NB°]

12.0;0.7;22.0;22.0;0.65;28.0;28.0;0.75;100.0

Farbe (RGB) 199;83;28
Plugin: Einwuchs Ingrowth2
Plugin: Konkurrenzindex Competition
Plugin: 
Schaftformfunktion

TaperFunctionBySchmidt
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Volumenfunktion 
Schaftholz [m³]

Tabelle 11: Baumart 511 – Fichte (Picea abies)
Durchmessergenerier
ung [cm]

t.d = (-2.492+1.104*sp.dg)*(((6.9/(-
2.492+1.104*sp.dg))^(3.418+0.353*sp.dg-0.192*dmax))-ln(1.0-
random))^(1.0/(3.418+0.353*sp.dg-0.192*dmax)) /* Fichte (NAGEL u. 
BIGING 1995) */

Einheitshöhenkurve 
[m]

t.h = 1.3+(sp.hg-1.3)*exp(0.18290951*(1.0-
(sp.dg/t.d)))*exp(5.68789430*((1.0/sp.dg)-(1.0/t.d))) /*Fichte (NAGEL 
1999)*/

Höhenvariabilität [m] t.hv = 0.1441427+0.5552640*ln(sp.BHD_STD) /* Fichte (ALBERT 
2000)*/

Volumenfunktion 
[m³]

t.v = 3.141592*t.h*(t.d/200)^2*(0.04016-27.56211/(t.d*t.d)
+1.36195/ln(t.d) +0.057654*t.h/t.d) /* Fichte Derbholz (BERGEL 1987)*/

Kronenbreite [m] t.cw = (1.2644+0.1072*t.d)*(1.0-exp(-exp(ln(t.d/0.000001)*1.0))) /* 
Fichte (NAGEL 1999)*/

Kronenansatz [m] t.cb = t.h*(1.0-exp(-abs((2.0417-0.3335*t.h/t.d+0.00906*t.d-
0.9004*ln(sp.h100))))) /* Fichte (DÖBBELER ET AL 2002) */

Kronentype in 
Grafik: 

Kronentyp= 1 (0=Laubholz, 1= Nadelholz) 

Bonität (Höhe im 
Alter 100) [m]

t.si = (sp.h100+49.87200-7.33090*ln(t.age)-0.77338*((ln(t.age))^2.0))/
(0.52684+0.10542*ln(t.age)) /*Fichte (NAGEL 1999)*/

Höhe entsprechend 
der Bonität [m] 

Höhe = -49.87200+7.33090*ln(t.age)
+0.77338*(ln(t.age)^2)+0.52684*t.si+0.10542*t.si*ln(t.age) /* Fichte 
(NAGEL 1999)*/

Potentieller 
Höhenzuwachs [m]

ihpot = ((1.2164*t.si*(1.0-exp(-0.0194*(t.age+5.0)))^1.1344)-
(1.2164*t.si*(1.0-exp(-0.0194*t.age))^1.1344)) /* Fichte (NAGEL 1999)*/

Höhenzuwachs [m] t.hinc = t.h*((((-
49.87200+7.33090*ln(t.age+5)+0.77338*((ln(t.age+5))^2.0)+0.52684*t.si
+0.10542*t.si*(ln(t.age+5)))-(-49.87200+7.33090*ln(t.age)
+0.77338*((ln(t.age))^2.0)+0.52684*t.si+0.10542*t.si*(ln(t.age))))/sp.h10
0 )+(0.00271*(t.hinc^2.1725))) /* Fichte (DÖBBELER ET AL 2002) */ 

Höhenzuwachsstreuu
ng [m]

herror = 0.082

ForestSimulator BWINPro 7.6 – Englisch Manual – Version April 2011



Appendix 44

Grundflächenzuwach
s [cm²]

t.dinc = exp(-6.2018+1.2984*ln(3.14159265359*(t.cw/2.0)/(6.0*(t.h-
t.cb)^2)*((4.0*(t.h-t.cb)^2 +(t.cw/2)^2)^1.5 - (t.cw/2)^3))-
0.9366*ln(t.age)-1.2835*t.c66xy+0.2962*t.c66cxy+0.2926*1.6094) /* 
Fichte (DÖBBELER ET AL 2002) */ 

Durchmesserzuwachs
streuung [cm]

herror = 0.638

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = 0.0001*3.141592/(16*0.0000012874*1.2842*(t.h^(0.7148-
1.1914))) /* Fichte Nordwest (DÖBBELER 2004) */ 

Maximales Alter 
[Jahre]

MaxAlter = 240

Totholzzersetzung 
(Faktor)

1.0-((sp.year-t.out-5.0)/50.0)

Zielstärkendurchmess
er [cm]

45.0

Höhe der 1. 
Durchforstung [m]

12.0

Mäßige 
Durchforstung 
[m;NB°]

12.0;0.7;20.0;20.0;0.75;26.0;26.0;0.8;100.0

Farbe (RGB) 0;102;255

Plugin: Einwuchs Ingrowth2

Plugin: 
Konkurrenzindex

Competition

Plugin: 
Schaftformfunktion

TaperFunctionBySchmidt

Volumenfunktion 
Schaftholz [m³]

3.141592*t.h*(t.d/200)^2*(0.5848+3.34262/(t.h*t.h)-1.73375/(t.h*t.d)-
0.26215*log(t.d)/log(10.0)+0.18736*log(t.h)/log(10.0)+11.34436/
(t.d*t.h*t.h)) /* Fichte Schaftholz (BERGEL 1973)*/

Tabelle 12: Baumart 611 – Douglasie (Pseudosuga menziezii)
Durchmessergenerierung 
[cm]

t.d = (-0.621+1.060*sp.dg)*(((6.9/(-
0.621+1.060*sp.dg))^(4.380+0.236*sp.dg-0.141*dmax))-ln(1.0-
random))^(1.0/(4.380+0.236*sp.dg-0.141*dmax)) /* Douglasie 
(NAGEL u. BIGING 1995) */

Einheitshöhenkurve [m] t.h = 1.3+(sp.hg-1.3)*exp(0.19965100*(1.0-
(sp.dg/t.d)))*exp(4.63277655*((1.0/sp.dg)-(1.0/t.d))) /* Douglasie 
(NAGEL 1999) */

Höhenvariabilität [m] t.hv = 0.2071047+0.5843520*ln(sp.BHD_STD) /* Douglasie 
(ALBERT 2000)*/

Volumenfunktion [m³] t.v = 3.141592*t.h*(t.d/200)^2*(-200.31914/(t.h*t.d*t.d)+0.8734/t.d-
0.0052*ln(t.d)*ln(t.d)+7.3594/(t.h*t.d)+0.46155) /* Douglasie 
Derbholz (BERGEL 1987)*/
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Kronenbreite [m] t.cw = (2.919+0.0939*t.d)*(1.0-exp(-exp(ln(t.d/10.0161)*1.362))) /* 
Douglasie (DÖBBELER ET AL 2002) */ 

Kronenansatz [m] t.cb = t.h*(1.0-exp(-abs((-1.8796+0.34056*t.h/t.d-
0.00610*t.d+0.8262*ln(sp.h100))))) /* Douglasie (DÖBBELER ET 
AL 2002) */ 

Kronentype in Grafik: Kronentyp= 1 (0=Laubholz, 1= Nadelholz) 
Bonität (Höhe im Alter 
100) [m]

t.si = (sp.h100+47.09070-11.4322*ln(t.age)+0.0*((ln(t.age))^2.0))/(-
0.0+0.20063*ln(t.age))/* Douglasie (NAGEL 1999)*/

Höhe entsprechend der 
Bonität [m] 

Höhe = -47.09070+11.4322*ln(t.age)-0.0*(ln(t.age)^2)-
0.0*t.si+0.20063*t.si*ln(t.age) /* Douglasie (NAGEL 1999)*/

Potentieller 
Höhenzuwachs [m]

ihpot = ((-47.09070+11.4322*ln(t.age+5)-0.0*((ln(t.age+5))^2.0)-
0.0*t.si+0.20063*t.si*(ln(t.age+5)))-(-47.09070+11.4322*ln(t.age)-
0.0*((ln(t.age))^2.0)-0.0*t.si+0.20063*t.si*(ln(t.age)))) /* Douglasie 
(NAGEL 1999)*/

Höhenzuwachs [m] t.hinc = t.h*((((-47.09070+11.4322*ln(t.age+5)-
0.0*((ln(t.age+5))^2.0)-0.0*t.si+0.20063*t.si*(ln(t.age+5)))-(-
47.09070+11.4322*ln(t.age)-0.0*((ln(t.age))^2.0)-
0.0*t.si+0.20063*t.si*(ln(t.age))))/sp.h100)+(0.00159*(t.hinc^2.5255)
)) /* Douglasie (DÖBBELER ET AL 2002) */

Höhenzuwachsstreuung 
[m]

herror = 0.082

Grundflächenzuwachs 
[cm²]

t.dinc = exp(-7.9766+1.5135*ln(3.14159265359*(t.cw/2.0)/(6.0*(t.h-
t.cb)^2)*((4.0*(t.h-t.cb)^2 +(t.cw/2)^2)^1.5 - (t.cw/2)^3))-
1.0009*ln(t.age)-0.4481*t.c66xy+0.5099*t.c66cxy+0.3038*1.6094) /* 
Douglasie (DÖBBELER ET AL 2002) */

Durchmesserzuwachsstre
uung [cm]

herror = 0.725

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = 0.0001*3.141592/
(16.0*0.00000089306*2.4088*(t.h^(0.7726-1.3555))) /* Douglasie 
suedwest (DÖBBELER 2004) */

Maximales Alter [Jahre] MaxAlter = 280
Totholzzersetzung 
(Faktor)

1.0-((sp.year-t.out-5.0)/50.0)

Zielstärkendurchmesser 
[cm]

65.0

Höhe der 1. 
Durchforstung [m]

14.0

Mäßige Durchforstung 
[m;NB°]

14.0;0.65;20.0;20.0;0.70;26.0;26.0;0.7;100.0

Farbe (RGB) 255;128;255
Plugin: Einwuchs Ingrowth2
Plugin: Konkurrenzindex Competition
Plugin: 
Schaftformfunktion

TaperFunctionBySchmidt
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Volumenfunktion 
Schaftholz [m³]

3.141592*t.h*(t.d/200)^2*(0.10798+0.71858/(log(t.d*10.0)/ 
log(10.0))+0.04065*(t.h/t.d)) /* Douglasie Schaftholz (BERGEL 
1971)*/

Tabelle 13: Baumart 711 – Kiefer (Pinus silvestris)
Durchmessergenerierung 
[cm]

t.d = (-0.047+1.047*sp.dg)*(((6.9/(-
0.047+1.047*sp.dg))^(3.640+0.332*sp.dg-0.180*dmax))-ln(1.0-
random))^(1.0/(3.640+0.332*sp.dg-0.180*dmax)) /* Kiefer (NAGEL 
u. BIGING 1995) */

Einheitshöhenkurve [m] t.h = 1.3+(sp.hg-1.3)*exp(0.25963741*(1.0-
(sp.dg/t.d)))*exp(1.30645374*((1.0/sp.dg)-(1.0/t.d))) /* Kiefer 
(NAGEL 1999) */

Höhenvariabilität [m] t.hv = -1.8315300+0.9701583*ln(sp.dg) /* Kiefer (ALBERT 2000) */
Volumenfunktion [m³] t.v = 3.141592*t.h*(t.d/200)^2*(0.40804-318.3342/(t.h*t.d*t.d)

+36.90522/(t.h*t.d)-4.05292/(t.d*t.d)) /* Kiefer Derbholz (BERGEL 
1987)*/

Kronenbreite [m] t.cw = (1.2783+0.11388*t.d)*(1.0-exp(-
exp(ln(t.d/8.705220)*1.33944))) /* Kiefer (DÖBBELER ET AL 2002) 
*/

Kronenansatz [m] t.cb = t.h*(1.0-exp(-abs((1.2085-0.2392*t.h/t.d+0.00742*t.d-
0.7897*ln(sp.h100))))) /* Kiefer (DÖBBELER ET AL 2002) */

Kronentype in Grafik: Kronentyp= 1 (0=Laubholz, 1= Nadelholz) 
Bonität (Höhe im Alter 
100) [m]

t.si = (sp.h100+31.67480-11.64500*ln(t.age)
+1.04989*((ln(t.age))^2.0))/(-0.43221+0.31253*ln(t.age)) /* Kiefer 
(NAGEL 1999) */

Höhe entsprechend der 
Bonität [m] 

Höhe = -31.67480+11.64500*ln(t.age)-1.04989*(ln(t.age)^2)-
0.43221*t.si+0.31253*t.si*ln(t.age) /* Kiefer (NAGEL 1999) */

Potentieller 
Höhenzuwachs [m]

ihpot = ((-31.67480+11.64500*ln(t.age+5)-
1.04989*((ln(t.age+5))^2.0)-0.43221*t.si+0.31253*t.si*(ln(t.age+5)))-
(-31.67480+11.64500*ln(t.age)-1.04989*((ln(t.age))^2.0)-
0.43221*t.si+0.31253*t.si*(ln(t.age)))) /* Kiefer (NAGEL 1999) */

Höhenzuwachs [m] t.hinc = t.h*((((-31.67480+11.64500*ln(t.age+5)-
1.04989*((ln(t.age+5))^2.0)-0.43221*t.si+0.31253*t.si*(ln(t.age+5)))-
(-31.67480+11.64500*ln(t.age)-1.04989*((ln(t.age))^2.0)-
0.43221*t.si+0.31253*t.si*(ln(t.age))))/sp.h100)+(0.0000*(t.hinc^1.0)
)) /* Kiefer (DÖBBELER ET AL 2002) */

Höhenzuwachsstreuung 
[m]

herror = 0.082

Grundflächenzuwachs 
[cm²]

t.dinc = exp(-5.0479+0.9508*ln(3.14159265359*(t.cw/2.0)/(6.0*(t.h-
t.cb)^2)*((4.0*(t.h-t.cb)^2 +(t.cw/2)^2)^1.5 - (t.cw/2)^3))-
0.7835*ln(t.age)-0.7639*t.c66xy+0.7113*t.c66cxy-0.1891*1.6094) /* 
Kiefer (DÖBBELER ET AL 2002) */

Durchmesserzuwachsstre
uung [cm]

herror = 0.649
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Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = 0.0001*3.141592/
(16*0.0000025729*0.2838*(t.h^(0.6277-0.7621))) /* Kiefer Nordwest 
(DÖBBELER 2004) */

Maximales Alter [Jahre] MaxAlter = 280
Totholzzersetzung 
(Faktor)

1.0-((sp.year-t.out-5.0)/50.0)

Zielstärkendurchmesser 
[cm]

45.0

Höhe der 1. 
Durchforstung [m]

12.0

Mäßige Durchforstung 
[m;NB°]

12.0;0.7;18.0;18.0;0.75;24.0;24.0;0.8;100.0

Farbe (RGB) 153;153;153
Plugin: Einwuchs Ingrowth2
Plugin: Konkurrenzindex Competition
Plugin: 
Schaftformfunktion

TaperFunctionBySchmidt

Volumenfunktion 
Schaftholz [m³]

3.141592*t.h*(t.d/200)^2* (0.35096+0.93964/t.d+1.5464/t.h-2.0482/ 
(t.d*t.d)-5.7305/(t.d*t.h)+17.444/(t.h*t.d*t.d) ) /* Kiefer Schaftholz 
(BERGEL 1974) */

Tabelle 14: Baumart 113 - Roteiche 
Durchmessergenerierung 
[cm]

t.d = (0.267+1.031*sp.dg)*(((6.9/
(0.267+1.031*sp.dg))^(6.122+0.374*sp.dg-0.258*dmax))-ln(1.0-
random))^(1.0/(6.122+0.374*sp.dg-0.258*dmax)) /* Roteiche 
(NAGEL u. BIGING 1995) */

Einheitshöhenkurve [m] t.h = 1.3+(sp.hg-1.3)*exp(0.26932445*(1.0-
(sp.dg/t.d)))*exp(4.32123002*((1.0/sp.dg)-(1.0/t.d))) /* Roteiche 
(NAGEL 1999) */

Höhenvariabilität [m] t.hv = -0.1944676+0.3535610*ln(sp.dg) /* Eiche (ALBERT 2000)*/
Volumenfunktion [m³] t.v = 3.141592*t.h*(t.d/200)^2*(0.4237+0.039178/t.d-4.69154/

(t.d*t.d)+38.5469/(t.h*t.d)-335.8731/(t.h*t.d*t.d)) /* Roteiche 
Derbholz (BERGEL 1974) */

Kronenbreite [m] t.cw = (2.6618+0.1152*t.d)*(1.0-exp(-exp(ln(t.d/8.3381)*1.4083))) /* 
Eiche (DÖBBELER ET AL 2002) */

Kronenansatz [m] t.cb = t.h*(1.0-exp(-abs((0.3652+0.3556*t.h/t.d-
0.00558*t.d+0.1373*ln(sp.h100))))) /* Roteiche (DÖBBELER ET AL 
2002) */

Kronentype in Grafik: Kronentyp= 0 (0=Laubholz, 1= Nadelholz) 
Bonität (Höhe im Alter 
100) [m]

t.si = sp.h100/(1.3952*(1.0-exp(-0.0321*t.age))^1.5033) /* Roteiche 
NAGEL 1999 */

Höhe entsprechend der Höhe = 1.3952*t.si*(1.0-exp(-0.0321*t.age))^1.5033 /* Roteiche 
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Bonität [m] NAGEL 1999 */
Potentieller Höhenzuwachs 
[m]

ihpot = ((1.3952*t.si*(1.0-exp(-0.0321*(t.age+5.0)))^1.5033)-
(1.3952*t.si*(1.0-exp(-0.0321*t.age))^1.5033)) /* Roteiche NAGEL 
1999 */

Höhenzuwachs [m] t.hinc = t.h*((((1.3952*t.si*(1.0-exp(-0.0321*(t.age+5.0)))^1.5033)-
(1.3952*t.si*(1.0-exp(-0.0321*t.age))^1.5033))/sp.h100)+(-
0.00102*(t.hinc^2.6855))) /* Roteiche (DÖBBELER ET AL 2002) */

Höhenzuwachsstreuung 
[m]

herror = 0.082

Grundflächenzuwachs 
[cm²]

t.dinc = exp(-6.7960+1.4050*ln((3.141593*(t.cw/2.0)/(6.0*(t.h-
t.cb)^2.0))*(((4.0*(t.h-t.cb)^2.0+(t.cw/2.0)^2.0)^1.5)-(t.cw/2.0)^3.0))-
0.8437*ln(t.age)-1.0990*t.c66xy+0.8281*t.c66cxy-0.2111*ln(5.0)) /* 
Roteiche (DÖBBELER ET AL 2002) */

Durchmesserzuwachsstreu
ung [cm]

herror = 0.569

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = (3.141592*(t.d/200.0)^2.0)*(18800.0/
(3.141592*(t.cw/2.0)^2.0)) /* Roteiche (DÖBBELER ET AL 2002) */

Maximales Alter [Jahre] MaxAlter = 300
Totholzzersetzung (Faktor) 1.0-((sp.year-t.out-5.0)/30.0)
Zielstärkendurchmesser 
[cm]

60.0

Höhe der 1. Durchforstung 
[m]

12.0

Mäßige Durchforstung 
[m;NB°]

12.0;0.75;18.0;18.0;0.80;24.0;24.0;0.85;100.0

Farbe (RGB) 255;255;20
Plugin: Einwuchs Ingrowth2
Plugin: Konkurrenzindex Competition
Plugin: Schaftformfunktion TaperFunctionBySchmidt

Tabelle 15: Baumart 221 – Hainbuche (Carpinus betulus)
Funktionen wie Code 211
Kronenbreite [m] t.cw = (3.002+0.1851*t.d) /* Hainbuche (DÖBBELER ET AL 2002) 

*/ 
Kronenansatz [m] t.cb = t.h*(1.0-exp(-abs((-0.8466+0.1534*t.h/t.d-

0.01084*t.d+0.6002*ln(sp.h100))))) /* Hainbuche (DÖBBELER ET 
AL 2002) */ 

Grundflächenzuwachs 
[cm²]

t.dinc = exp(-8.7786+1.1773*ln(3.14159265359*(t.cw/2.0)/(6.0*(t.h-
t.cb)^2)*((4.0*(t.h-t.cb)^2 +(t.cw/2)^2)^1.5 - (t.cw/2)^3))-
0.3176*ln(t.age)-0.5691*t.c66xy+0.0*t.c66cxy-0.7319*ln(5.0)) /* 
Hainbuche (DÖBBELER ET AL 2002) c66c auf nNull gesetzt*/ 

Durchmesserzuwachsstreu
ung [cm]

herror = 0.762
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Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = (3.141592*(t.d/200.0)^2.0)*(21100/
(3.141592*(t.cw/2.0)^2.0)) /* Hainbuche (DÖBBELER ET AL 2002) 
*/ 

Maximales Alter [Jahre] MaxAlter = 300
Totholzzersetzung 
(Faktor)

1.0-((sp.year-t.out-5.0)/30.0)

Zielstärkendurchmesser 
[cm]

65.0

Höhe der 1. 
Durchforstung [m]

12.0

Mäßige Durchforstung 
[m;NB°]

12.0;0.7;22.0;22.0;0.65;28.0;28.0;0.75;100.0

Farbe (RGB) 199;83;28

Tabelle 16: Baumart 311 – Esche (Fraxinus excelsior)
Durchmessergenerierung 
[cm]

t.d = (-1.937+1.082*sp.dg)*(((6.9/(-
1.937+1.082*sp.dg))^(4.669+0.366*sp.dg-0.234*dmax))-ln(1.0-
random))^(1.0/(4.669+0.366*sp.dg-0.234*dmax)) /* Eiche (NAGEL 
u. BIGING 1995) */

Einheitshöhenkurve [m] t.h = 1.3+(sp.hg-1.3)*exp(0.14657227*(1.0-(sp.dg/t.d)))* 
exp(3.78686023*((1.0/sp.dg)-(1.0/t.d))) /*Eiche (NAGEL 1999) */

Höhenvariabilität [m] t.hv = -0.1944676+0.3535610*ln(sp.dg) /*Buche (ALBERT 2000) */
Volumenfunktion [m³] t.v = 3.141592*t.h*(t.d/200)^2*(0.4786-(1.011176/t.d)+(2.10428/t.h)-

(203.1997/(t.d*t.h*t.h))) /*Buche Derbholz (BERGEL 1973) */
Kronenbreite [m] t.cw = (17.372-0.0646*t.d)*(1.0-exp(-exp(ln(t.d/45.371)*1.238)))/* 

Esche (DÖBBELER ET AL 2002) */ 
Kronenansatz [m] t.cb = t.h*(1.0-exp(-abs((-0.3708+0.4211*t.h/t.d-

0.0030*t.d+0.3242*ln(sp.h100))))) /* Esche (DÖBBELER ET AL 
2002) */ 

Kronentype in Grafik: Kronentyp= 0 (0=Laubholz, 1= Nadelholz) 
Bonität (Höhe im Alter 
100) [m]

t.si = (sp.h100+46.046-15.81886*ln(t.age)
+1.33618*((ln(t.age))^2.0))/(0.00000+0.22808*ln(t.age)) /* Esche 
(NAGEL 1999) */ 

Höhe entsprechend der 
Bonität [m] 

Höhe = -46.046+15.81886*ln(t.age)-
1.33618*(ln(t.age)^2)+0.0*t.si+0.22808*t.si*ln(t.age)/* Esche 
(NAGEL 1999) */ 

Potentieller 
Höhenzuwachs [m]

ihpot = ((-46.046+15.81886*ln(t.age+5)-
1.33618*((ln(t.age+5))^2.0)+0.22808*t.si*(ln(t.age+5)))-(-
46.046+15.81886*ln(t.age)-
1.33618*((ln(t.age))^2.0)+0.22808*t.si*(ln(t.age) /* Esche (NAGEL 
1999) */ 
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Höhenzuwachs [m] t.hinc = t.h*((((-46.046+15.81886*ln(t.age+5)-
1.33618*((ln(t.age+5))^2.0)+0.22808*t.si*(ln(t.age+5)))-(-
46.046+15.81886*ln(t.age)-
1.33618*((ln(t.age))^2.0)+0.22808*t.si*(ln(t.age))))/sp.h100)+(0.0*(t
.hinc^1.0)))/* Esche (DÖBBELER ET AL 2002) */ 

Höhenzuwachsstreuung 
[m]

herror = 0.082

Grundflächenzuwachs 
[cm²]

t.dinc = exp(-6.1407+1.1068*ln((3.141593*(t.cw/2.0)/(6.0*(t.h-
t.cb)^2.0))*(((4.0*(t.h-t.cb)^2.0+(t.cw/2.0)^2.0)^1.5)-
(t.cw/2.0)^3.0))-0.5533*ln(t.age)-1.2802*t.c66xy+2.1916*t.c66cxy-
0.5044*ln(5.0))/* Esche (DÖBBELER ET AL 2002) */ 

Durchmesserzuwachsstreu
ung [cm]

herror = 0.685

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = (3.141592*(t.d/200.0)^2.0)*(14100.0/
(3.141592*(t.cw/2.0)^2.0))/* Esche (DÖBBELER ET AL 2002) */ 

Maximales Alter [Jahre] MaxAlter = 300
Totholzzersetzung 
(Faktor)

1.0-((sp.year-t.out-5.0)/30.0)

Zielstärkendurchmesser 
[cm]

60.0

Höhe der 1. Durchforstung 
[m]

12.0

Mäßige Durchforstung 
[m;NB°]

12.0;0.85;18.0;18.0;0.90;24.0;24.0;0.95;100.0

Farbe (RGB) 0;153;0

Tabelle 17: Baumart 321 - Bergahron
Durchmessergenerierung 
[cm]

t.d = (-1.937+1.082*sp.dg)*(((6.9/(-
1.937+1.082*sp.dg))^(4.669+0.366*sp.dg-0.234*dmax))-ln(1.0-
random))^(1.0/(4.669+0.366*sp.dg-0.234*dmax)) /* Eiche (NAGEL 
u. BIGING 1995) */

Einheitshöhenkurve [m] t.h = 1.3+(sp.hg-1.3)*exp(0.14657227*(1.0-
(sp.dg/t.d)))*exp(3.78686023*((1.0/sp.dg)-(1.0/t.d))) /*Eiche 
(NAGEL 1999*/

Höhenvariabilität [m] t.hv = -0.1944676+0.3535610*ln(sp.dg) /*Buche (ALBERT 2000) 
*/

Volumenfunktion [m³] t.v = 3.141592*t.h*(t.d/200)^2*(0.4786-(1.011176/t.d)
+(2.10428/t.h)-(203.1997/(t.d*t.h*t.h))) /*Buche Derbholz 
(BERGEL 1973) */

Kronenbreite [m] t.cw = (2.7916+0.1340*t.d)*(1.0-exp(-
exp(ln(t.d/2.7198)*0.4197))) /* Ahorn (DÖBBELER ET AL 2002) 
*/ 

Kronenansatz [m] t.cb = t.h*(1.0-exp(-abs((-0.3191+0.0475*t.h/t.d-0.0057*t.d+ 
0.4066*ln(sp.h100))))) /* Ahorn (DÖBBELER ET AL 2002) */ 
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Kronentype in Grafik: Kronentyp= 0 (0=Laubholz, 1= Nadelholz) 
Bonität (Höhe im Alter 
100) [m]

t.si = 296.0432*(sp.h100/296.0432)^(1.0/exp( (-0.62388/((1.30296-
1.0)* 100.0^(1.30296-1.0)))+(0.62388/((1.30296-
1.0)*t.age^(1.30296-1.0))) )) /* NAGEL 1985 */ 

Höhe entsprechend der 
Bonität [m] 

Höhe = 296.0432*(t.si/296.0432)^exp((-0.62388/((1.30296-
1.0)*100.0^(1.30296-1.0)))+(0.62388/((1.30296-
1.0)*t.age^(1.30296-1.0)))) /* NAGEL 1985 */ 

Potentieller 
Höhenzuwachs [m]

ihpot = (296.0432*(t.si/296.0432)^exp((-0.62388/((1.30296-
1.0)*100.0^(1.30296-1.0)))+(0.62388/((1.30296-
1.0)*(t.age+5.0)^(1.30296-1.0))))-296.0432*(t.si/296.0432)^exp((-
0.62388/((1.30296-1.0)*100.0^(1.30296-1.0)))+(0.62388/((1.30296-
1.0)*t.age^(1.30296-1.0))))) /* NAGEL 1985 */ 

Höhenzuwachs [m] t.hinc = t.h*(((296.0432*(t.si/296.0432)^exp((-0.62388/((1.30296-
1.0)*100.0^(1.30296-1.0)))+(0.62388/((1.30296-
1.0)*(t.age+5.0)^(1.30296-1.0))))-296.0432*(t.si/296.0432)^exp((-
0.62388/((1.30296-1.0)*100.0^(1.30296-1.0)))+(0.62388/((1.30296-
1.0)*t.age^(1.30296-1.0)))))/sp.h100)+(0.0*(t.hinc^1.0))) /* Ahorn 
(DÖBBELER ET AL 2002) */ 

Höhenzuwachsstreuung 
[m]

herror = 0.082

Grundflächenzuwachs 
[cm²]

t.dinc = exp(-5.9842+1.3801*ln((3.141593*(t.cw/2.0)/(6.0*(t.h-
t.cb)^2.0))* (((4.0*(t.h-t.cb)^2.0+(t.cw/2.0)^2.0)^1.5)-
(t.cw/2.0)^3.0))-0.7104*ln(t.age)-0.7518* t.c66xy+0.0*t.c66cxy-
1.0577*ln(5.0)) /* Ahorn (DÖBBELER ET AL 2002) */ 

Durchmesserzuwachsstre
uung [cm]

herror = 0.563

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = (3.141592*(t.d/200.0)^2.0)*(19800.0/
(3.141592*(t.cw/2.0)^2.0)) /* Ahorn (DÖBBELER ET AL 2002) */ 

Maximales Alter [Jahre] MaxAlter = 280
Totholzzersetzung 
(Faktor)

1.0-((sp.year-t.out-5.0)/30.0)

Zielstärkendurchmesser 
[cm]

60.0

Höhe der 1. 
Durchforstung [m]

12.0

Mäßige Durchforstung 
[m;NB°]

12.0;0.55;18.0;18.0;0.60;24.0;24.0;0.65;100.0

Farbe (RGB) 0;153;0

Tabelle 18: Baumart 342 – Winterlinde (Tilia cordata)
wie 211 
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Bonität (Höhe im Alter 100) 
[m]

t.si = 96.173358*(sp.h100/96.173358)^(1.0/exp( (-0.495586/
((1.101126-1.0)*100.0^(1.101126-1.0)))+(0.495586/((1.101126-
1.0)*t.age^(1.101126-1.0))) )) /* BÖCKMANN 1990 */ 

Höhe entsprechend der Bonität 
[m] 

Höhe = 96.173358*(t.si/96.173358)^exp((-0.495586/((1.101126-
1.0)*100.0^(1.101126-1.0)))+(0.495586/((1.101126-
1.0)*t.age^(1.101126-1.0))))/* BÖCKMANN 1990 */ 

Potentieller Höhenzuwachs 
[m]

ihpot = (96.173358*(t.si/96.173358)^exp((-0.495586/((1.101126-
1.0)*100.0^(1.101126-1.0)))+(0.495586/((1.101126-
1.0)*(t.age+5.0)^(1.101126-1.0))))-
96.173358*(t.si/96.173358)^exp((-0.495586/((1.101126-
1.0)*100.0^(1.101126-1.0)))+(0.495586/((1.101126-
1.0)*t.age^(1.101126-1.0))))) /* BÖCKMANN 1990 */ 

Höhenzuwachs [m] t.hinc = (96.173358*(t.si/96.173358)^exp((-0.495586/((1.101126-
1.0)*100.0^(1.101126-1.0)))+(0.495586/((1.101126-
1.0)*(t.age+5.0)^(1.101126-1.0))))-
96.173358*(t.si/96.173358)^exp((-0.495586/((1.101126-
1.0)*100.0^(1.101126-1.0)))+(0.495586/((1.101126-
1.0)*t.age^(1.101126-1.0)))))/* BÖCKMANN 1990 */

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = (3.141592*(t.d/200.0)^2.0)*(14600.0/
(3.141592*(t.cw/2.0)^2.0))

Maximales Alter [Jahre] MaxAlter = 280

Tabelle 19: Baumart 354 – Kirsche (Prunus avium)
wie 211
Bonität (Höhe im Alter 100) 
[m]

t.si = 84.185464*(sp.h100/84.185464)^(1.0/exp( (-0.800089/
((1.150926-1.0)*100.0^(1.150926-1.0)))+(0.800089/((1.150926-
1.0)*t.age^(1.150926-1.0))) )) /* RÖÖS 1990 */ 

Höhe entsprechend der Bonität 
[m] 

Höhe = 84.185464*(t.si/84.185464)^exp((-0.800089/((1.150926-
1.0)*100.0^(1.150926-1.0)))+(0.800089/((1.150926-
1.0)*t.age^(1.150926-1.0)))) /* RÖÖS 1990 */ 

Potentieller Höhenzuwachs 
[m]

ihpot = (84.185464*(t.si/84.185464)^exp((-0.800089/((1.150926-
1.0)*100.0^(1.150926-1.0)))+(0.800089/((1.150926-
1.0)*(t.age+5.0)^(1.150926-1.0))))-
84.185464*(t.si/84.185464)^exp((-0.800089/((1.150926-
1.0)*100.0^(1.150926-1.0)))+(0.800089/((1.150926-
1.0)*t.age^(1.150926-1.0))))) /* RÖÖS 1990 */ 

Höhenzuwachs [m] t.hinc = (84.185464*(t.si/84.185464)^exp((-0.800089/((1.150926-
1.0)* 100.0^(1.150926-1.0)))+(0.800089/((1.150926-
1.0)*(t.age+5.0)^(1.150926-1.0))))-
84.185464*(t.si/84.185464)^exp((-0.800089/((1.150926-1.0)* 
100.0^(1.150926-1.0)))+(0.800089/((1.150926-
1.0)*t.age^(1.150926-1.0))))) /* RÖÖS 1990 */ 

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = (3.141592*(t.d/200.0)^2.0)*(15400.0/
(3.141592*(t.cw/2.0)^2.0))

ForestSimulator BWINPro 7.6 – Englisch Manual – Version April 2011



Appendix
53

Tabelle 20: Baumart 357 - Elsbeere (Sorbus torminalis)
Durchmessergenerierung [cm] t.d = (-1.937+1.082*sp.dg)*(((6.9/(-

1.937+1.082*sp.dg))^(4.669+0.366*sp.dg-0.234*dmax))-ln(1.0-
random))^(1.0/(4.669+0.366*sp.dg-0.234*dmax)) /* Eiche 
(NAGEL u. BIGING 1995) */

Einheitshöhenkurve [m] t.h = 1.3+(sp.hg-1.3)*exp(0.14657227*(1.0-
(sp.dg/t.d)))*exp(3.78686023*((1.0/sp.dg)-(1.0/t.d))) /*Eiche 
(NAGEL 1999*/

Höhenvariabilität [m] t.hv = -0.1944676+0.3535610*ln(sp.dg) /*Buche (ALBERT 2000) 
*/

Volumenfunktion [m³] t.v = 3.141592*t.h*(t.d/200)^2*(0.4786-(1.011176/t.d)
+(2.10428/t.h)-(203.1997/(t.d*t.h*t.h))) /*Eiche Derbholz 
(BERGEL 1974)*/

Kronenbreite [m] t.cw = (2.227+0.121*t.d)*(1.0-exp(-exp(ln(t.d/5.332)*2.261))) /* 
KAHLE 2004 */ 

Kronenansatz [m] t.cb = t.h*(1.0-exp(-(0.629+0.197*(t.h/t.d))^2.0)) /* KAHLE 2004 
*/ 

Kronentype in Grafik: Kronentyp= 0 (0=Laubholz, 1= Nadelholz) 
Bonität (Höhe im Alter 100) 
[m]

t.si = 785.400774*(sp.h100/785.400774)^(1.0/exp( (-0.20576727/
((1.03088451-1.0)*100.0^(1.03088451-1.0)))+(0.20576727/
((1.03088451-1.0)*t.age^(1.03088451-1.0))) )) /* KAHLE 2004 */ 

Höhe entsprechend der Bonität 
[m] 

Höhe = 785.400774*(t.si/785.400774)^exp((-0.20576727/
((1.03088451-1.0)*100.0^(1.03088451-1.0)))+(0.20576727/
((1.03088451-1.0)*t.age^(1.03088451-1.0)))) /* KAHLE 2004 */ 

Potentieller Höhenzuwachs 
[m]

ihpot = (785.400774*(t.si/785.400774)^exp((-0.20576727/
((1.03088451-1.0)*100.0^(1.03088451-1.0)))+(0.20576727/
((1.03088451-1.0)*(t.age+5.0)^(1.03088451-1.0))))-
785.400774*(t.si/785.400774)^exp((-0.20576727/((1.03088451-
1.0)*100.0^(1.03088451-1.0)))+(0.20576727/((1.03088451-
1.0)*t.age^(1.03088451-1.0)))))/sp.h100 /* KAHLE 2004 */ 

Höhenzuwachs [m] t.hinc = t.hinc
Höhenzuwachsstreuung [m] herror = 0.082
Grundflächenzuwachs [cm²] t.dinc = exp(-5.755+1.073*ln((3.141593*(t.cw/2.0)/(6.0*(t.h-

t.cb)^2.0))*(((4.0*(t.h-t.cb)^2.0+(t.cw/2.0)^2.0)^1.5)-
(t.cw/2.0)^3.0))-0.882*ln(t.age)-0.727*t.c66xy) /* KAHLE 2004 
*/ 

Durchmesserzuwachsstreuung 
[cm]

herror = 0.563

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = (3.141592*(t.d/200.0)^2.0)*(19800.0/
(3.141592*(t.cw/2.0)^2.0)) /* KAHLE 2004 */ 

Maximales Alter [Jahre] MaxAlter = 280
Totholzzersetzung (Faktor) 1.0-((sp.year-t.out-5.0)/30.0)
Zielstärkendurchmesser [cm] 60.0
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Höhe der 1. Durchforstung [m] 12.0
Mäßige Durchforstung 
[m;NB°]

12.0;0.55;18.0;18.0;0.60;24.0;24.0;0.65;100.0

Farbe (RGB) 0;153;0

Tabelle 21: Baumart 412 – Moorbirke (Betula pubescens)
Durchmessergenerierung 
[cm]

t.d = (-1.937+1.082*sp.dg)*(((6.9/(-
1.937+1.082*sp.dg))^(4.669+0.366*sp.dg-0.234*dmax))-ln(1.0-
random))^(1.0/(4.669+0.366*sp.dg-0.234*dmax)) /* Eiche (NAGEL 
u. BIGING 1995) */

Einheitshöhenkurve [m] t.h = 1.3+(sp.hg-1.3)*exp(0.14657227*(1.0-
(sp.dg/t.d)))*exp(3.78686023*((1.0/sp.dg)-(1.0/t.d))) /* Eiche 
(NAGEL 1999)*/

Höhenvariabilität [m] t.hv = -0.1944676+0.3535610*ln(sp.dg) /* Eiche (ALBERT 2000)*/
Volumenfunktion [m³] t.v = 3.141592*t.h*(t.d/200)^2*(0.4039+0.0017335*t.h+1.1267/t.h-

118.188/(t.d*t.d*t.d)+0.0000042*t.d*t.d) /*Buche Derbholz 
(BERGEL 1973) */

Kronenbreite [m] t.cw = 0.38051+0.221417*t.d /* Moorbirke (NAGEL 2009*/ 
Kronenansatz [m] t.cb = t.h*(1.0-exp(-abs((-

0.586706+0.445061*t.h/t.d+0.008464*t.d+0.27464*ln(sp.h100))))) /* 
Moorbirke (NAGEL 2009*/ 

Kronentype in Grafik: Kronentyp= 0 (0=Laubholz, 1= Nadelholz) 
Bonität (Höhe im Alter 
100) [m]

t.si = sp.h100*((1.0-exp(-0.0658938*100.0))/(1.0-exp(-
0.0658938*t.age)) )^4.1319191 /* Moorbirke Lock ausgeglichen 
(NAGEL 2009) */ 

Höhe entsprechend der 
Bonität [m] 

Höhe = t.si/((1.0-exp(-0.0658938*100.0))/(1.0-exp(-
0.0658938*t.age)) )^4.1319191 /* Moorbirke Lock ausgeglichen 
(NAGEL 2009*/ 

Potentieller 
Höhenzuwachs [m]

ihpot = ((t.si/((1.0-exp(-0.0658938*100.0))/(1.0-exp(-
0.0658938*(t.age+5.0))) )^4.1319191)-(t.si/((1.0-exp(-
0.0658938*100.0))/(1.0-exp(-0.0658938*(t.age))) )^4.1319191 )) /* 
Moorbirke Lock ausgeglichen (NAGEL 2009*/ 

Höhenzuwachs [m] t.hinc = ((t.si/((1.0-exp(-0.0658938*100.0))/(1.0-exp(-
0.0658938*(t.age+5.0))) )^4.1319191)-(t.si/((1.0-exp(-
0.0658938*100.0))/(1.0-exp(-0.0658938*(t.age))) )^4.1319191 )) /* 
Moorbirke Lock ausgeglichen (NAGEL 2009*/ 

Höhenzuwachsstreuung 
[m]

herror = 0.05

Grundflächenzuwachs 
[cm²]

t.dinc = (exp(4.972+1.52733*ln(3.14159265359*(t.cw/2.0)/(6.0*(t.h-
t.cb)^2)*((4.0*(t.h-t.cb)^2 +(t.cw/2)^2)^1.5 - (t.cw/2)^3))-
1.75899*ln(t.age)-1.52027*t.c66xy-1.077*t.c66cxy))/10000 /* 
Moorbirke (NAGEL 2009*/ 

Durchmesserzuwachsstreu
ung [cm]

herror = 0.05
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Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = (3.141592*(t.d/200.0)^2.0)*(9900.0/
(3.141592*(t.cw/2.0)^2.0)) /* Moorbirke (NAGEL 2009*/ 

Maximales Alter [Jahre] MaxAlter = 90
Totholzzersetzung 
(Faktor)

1.0-((sp.year-t.out-5.0)/30.0)

Zielstärkendurchmesser 
[cm]

40.0

Höhe der 1. 
Durchforstung [m]

12.0

Mäßige Durchforstung 
[m;NB°]

12.0;0.55;18.0;18.0;0.60;24.0;24.0;0.65;100.0

Farbe (RGB) 204;204;0

Tabelle 22: Baumart 421 – Roterle (Schwarzerle) 
Durchmessergenerierung 
[cm]

t.d = (-1.937+1.082*sp.dg)*(((6.9/(-
1.937+1.082*sp.dg))^(4.669+0.366*sp.dg-0.234*dmax))-ln(1.0-
random))^(1.0/(4.669+0.366*sp.dg-0.234*dmax)) /* Eiche (NAGEL 
u. BIGING 1995) */

Einheitshöhenkurve [m] t.h = 1.3+(sp.hg-1.3)*exp(0.14657227*(1.0-
(sp.dg/t.d)))*exp(3.78686023*((1.0/sp.dg)-(1.0/t.d))) /* Eiche 
(NAGEL 1999)*/

Höhenvariabilität [m] t.hv = -0.1944676+0.3535610*ln(sp.dg) /* Eiche (ALBERT 2000)*/
Volumenfunktion [m³] t.v = exp(-10.262754+2.155525*ln(t.d) +0.976678* ln(t.h)-

0.043148*(ln(t.d))^2 +0.010716 * (ln(t.h)) ^2 *(1.811999-
7.382763*(1.0/t.d)- 0.032335*t.d+0.0005276708*t.d^2)- 
0.00000246995 *t.d^3.0) /*Schwarzerle LOCKOW (1994)*/

Kronenbreite [m] t.cw = 0.17998*(t.d^0.75155)*((t.h-t.cb)^0.35611) /*Schwarzerle 
SCHRÖDER ()*/

Kronenansatz [m] t.cb = t.h*(1.0-exp(-abs((-1.662864+0.166908*t.h/t.d-
0.013784*t.d+0.977588*ln(sp.h100))))) /*Schwarzerle SCHRÖDER 
()*/

Kronentype in Grafik: Kronentyp= 0 (0=Laubholz, 1= Nadelholz) 
Bonität (Höhe im Alter 
100) [m]

t.si = 4.0*sp.h100*exp(2.733015-1.668158*ln(t.age)
+0.167998*ln(t.age)^2.0) /*Schwarzerle LOCKOW (1994)*/

Höhe entsprechend der 
Bonität [m] 

Höhe = t.si/(4.0*exp(2.733015-
1.668158*ln(t.age+5)+0.167998*ln(t.age+5)^2.0)) /*Schwarzerle 
LOCKOW (1994)*/

Potentieller Höhenzuwachs 
[m]

ihpot = ((1.2164*t.si*(1.0-exp(-0.0194*(t.age+5.0)))^1.1344)-
(1.2164*t.si*(1.0-exp(-0.0194*t.age))^1.1344)) /*Schwarzerle Lockow 
(1994)*/

Höhenzuwachs [m] t.hinc = ((1.2164*t.si*(1.0-exp(-0.0194*(t.age+5.0)))^1.1344)-
(1.2164*t.si*(1.0-exp(-0.0194*t.age))^1.1344))
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Höhenzuwachsstreuung 
[m]

herror = 0.05

Grundflächenzuwachs 
[cm²]

t.dinc = exp(-7.23687+1.05135*ln(3.14159265359*(t.cw/2.0)/
(6.0*(t.h-t.cb)^2)*((4.0*(t.h-t.cb)^2 +(t.cw/2)^2)^1.5 - (t.cw/2)^3))-
0.50283*ln(t.age)-0.80185*t.c66xy) /*Schwarzerle SCHRÖDER ()*/

Durchmesserzuwachsstreu
ung [cm]

herror = 0.05

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = (3.141592*(sp.dg/200.0)^2.0)*(5518.3*exp(-
0.0645*sp.dg)) /*Schwarzerle Schröder*/

Maximales Alter [Jahre] MaxAlter = 125
Totholzzersetzung (Faktor) 1.0-((sp.year-t.out-5.0)/30.0)
Zielstärkendurchmesser 
[cm]

40.0

Höhe der 1. Durchforstung 
[m]

12.0

Mäßige Durchforstung 
[m;NB°]

12.0;0.55;18.0;18.0;0.60;24.0;24.0;0.65;100.0

Farbe (RGB) 204;204;0
Plugin: Einwuchs Ingrowth2
Plugin: Konkurrenzindex Competition
Plugin: Schaftformfunktion TaperFunctionBySchmidt

Tabelle 23: Baumart 451 – Eberesche (Sorbus aucuparia)
wie 211 
Volumenfunktion [m³] t.v = 

0.000904+0.96266*(0.0000272*t.h*t.d^2+0.00007719*t.d*t.h+ 
0.000058*t.h)
+0.13248*(0.0000272*t.h*t.d^2+0.00007719*t.d*t.h+ 
0.000058*t.h)^2 /*Eberesche (HILLEBRAND 1996)*/

Kronenbreite [m] t.cw = 1.02199+0.13849*t.d /*Eberesche (Hillebrand 1996)*/
Kronenansatz [m] t.cb = t.h*(1.0-exp(-(0.74928+0.21639*t.h/t.d)^2.0))
Kronentype in Grafik: Kronentyp= 0 (0=Laubholz, 1= Nadelholz) 
Bonität (Höhe im Alter 100) 
[m]

t.si = 66.9903*(sp.h100/66.9903)^(1.0/exp( (-0.23515/((0.79707-
1.0)*100.0^(0.79707-1.0)))+(0.23515/((0.79707-
1.0)*t.age^(0.79707-1.0))) )) /*Eberesche (HILLEBRAND 
1996)*/

Höhe entsprechend der Bonität 
[m] 

Höhe = 66.9903*(t.si/66.9903)^exp((-0.23515/((0.79707-
1.0)*100.0^(0.79707-1.0)))+(0.23515/((0.79707-
1.0)*t.age^(0.79707-1.0)))) /*Eberesche (HILLEBRAND 1996)*/
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Potentieller Höhenzuwachs 
[m]

ihpot = (66.9903*(t.si/66.9903)^exp((-0.23515/((0.79707-
1.0)*100.0^(0.79707-1.0)))+(0.23515/((0.79707-
1.0)*(t.age+5.0)^(0.79707-1.0))))-66.9903* (t.si/66.9903)^exp((-
0.23515/((0.79707-1.0)*100.0^(0.79707-1.0)))+(0.23515/
((0.79707-1.0)*t.age^(0.79707-1.0))))) /*Eberesche 
(HILLEBRAND 1996)*/

Höhenzuwachs [m] t.hinc = (66.9903*(t.si/66.9903)^exp((-0.23515/((0.79707-
1.0)*100.0^(0.79707-1.0)))+(0.23515/((0.79707-
1.0)*(t.age+5.0)^(0.79707-1.0))))-66.9903* (t.si/66.9903)^exp((-
0.23515/((0.79707-1.0)*100.0^(0.79707-1.0)))+(0.23515/
((0.79707-1.0)*t.age^(0.79707-1.0))))) /*Eberesche 
(HILLEBRAND 1996)*/

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = (3.141592*(t.d/200.0)^2.0)*(17700.0/
(3.141592*(t.cw/2.0)^2.0))

Maximales Alter [Jahre] MaxAlter = 120
Totholzzersetzung (Faktor) 1.0-((sp.year-t.out-5.0)/30.0)
Zielstärkendurchmesser [cm] 60.0
Höhe der 1. Durchforstung 
[m]

12.0

Mäßige Durchforstung 
[m;NB°]

12.0;0.55;18.0;18.0;0.60;24.0;24.0;0.65;100.0

Farbe (RGB) 204;204;0

Tabelle 24: Baumart 521 – Weisstanne (Abies alba)
wie 511
Kronenbreite [m] t.cw = 1.84810+0.10350*t.d /*Weisstanne (NAGEL 

1999)*/
Kronenansatz [m] t.cb = t.h*(1.0-exp(-(0.784+0.207*t.h/t.d)^2.0)) /* 

Weisstanne (NAGEL 1999)*/
Maximale Dichte der Grundfläche 
[m²/ha]

MaxDichte = (3.141592*(t.d/200.0)^2.0)*(15000.0/
(3.141592*(t.cw/2.0)^2.0)) 

Tabelle 25: Baumart 523 – Küstentanne (Abies grandis)
wie 511 
Volumenfunktion [m³] t.v = exp(1.64134*ln(t.d)+0.84522*ln(t.h-1.3)+0.45253*ln(1.0-

(7.0/t.d))-8.45379) /* Kta Derbholz Nagel 1988*/
Kronenbreite [m] t.cw = (3.152709+0.064306*t.d)*(1.0-exp(-

exp(ln(t.d/14.069376)*1.938416))) /*Kta (GEB 2009*/
Kronenansatz [m] t.cb = t.h*(1.0-exp(-abs((-1.7040199+0.5945605*t.h/t.d-

0.0067069*t.d+0.6850744*ln(sp.h100))))) /* Kta (GEB 2009) */
Kronentype in Grafik: Kronentyp= 1 (0=Laubholz, 1= Nadelholz) 
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Bonität (Höhe im Alter 100) 
[m]

t.si = sp.h100*((1.0-exp(-0.0371*50.0))/(1.0-exp(-
0.0371*t.age)) )^2.08562 /* Kta (GEB 2009) */

Höhe entsprechend der Bonität 
[m] 

Höhe = t.si/((1.0-exp(-0.0371*50.0))/(1.0-exp(-0.0371*t.age)) )
^2.08562 /* Kta (GEB 2009) */

Potentieller Höhenzuwachs [m] ihpot = ((t.si/((1.0-exp(-0.0371*50.0))/(1.0-exp(-
0.0371*(t.age+5.0))) )^2.08562)-(t.si/((1.0-exp(-0.0371*50.0))/
(1.0-exp(-0.0371*(t.age))) )^2.08562 )) /* Kta (GEB 2009) */

Höhenzuwachs [m] t.hinc = ((t.si/((1.0-exp(-0.0371*50.0))/(1.0-exp(-
0.0371*(t.age+5.0))) )^2.08562)-(t.si/((1.0-exp(-0.0371*50.0))/
(1.0-exp(-0.0371*(t.age))) )^2.08562 )) 
*1.053041*(t.h/sp.h100)^0.021848 /* Kta (GEB 2009) */

Höhenzuwachsstreuung [m] herror = 1.29
Grundflächenzuwachs [cm²] t.dinc = (exp(3.5581+1.018355*ln(t.d*t.d)-1.207076*ln(t.age)-

0.968107*t.c66xy+0.541826*t.c66cxy))/10000.0 /* Kta (GEB 
2009) */

Durchmesserzuwachsstreuung 
[cm]

herror = -9.0

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = 0.0001*3.141592/
(16*0.000005758*0.7637*(t.h^(0.2706-1.0760))) /* Kta (GEB 
2009) */

Maximales Alter [Jahre] MaxAlter = 200
Totholzzersetzung (Faktor)
Zielstärkendurchmesser [cm] 60.0
Höhe der 1. Durchforstung [m] 10.0
Mäßige Durchforstung 
[m;NB°]

10.0;0.6;20.0;20.0;0.6;26.0;30.0;0.8;100.0

Tabelle 26: Baumart 811 – Europäische Lärche (Larix decidua)
Durchmessergenerierung [cm] t.d = (-2.492+1.104*sp.dg)*(((6.9/(-

2.492+1.104*sp.dg))^(3.418+0.353*sp.dg-0.192*dmax))-ln(1.0-
random))^(1.0/(3.418+0.353*sp.dg-0.192*dmax)) /* Fichte 
(NAGEL u. BIGING 1995) */

Einheitshöhenkurve [m] t.h = 1.3+(sp.hg-1.3)*exp(0.12931522*(1.0-
(sp.dg/t.d)))*exp(4.44234560*((1.0/sp.dg)-(1.0/t.d))) /*ELae 
(NAGEL 1999*/

Höhenvariabilität [m] t.hv = -0.6860345+0.551803*ln(sp.dg) /* ELae (ALBERT 2000)*/
Volumenfunktion [m³] t.v = 3.141592*t.h*(t.d/200)^2*(0.583+4.52132/(t.h*t.h)-5.59827/ 

(t.h*t.d)-0.2101*ln(t.d)/ln(10.0)+ 
0.12363*ln(t.h)/ln(10.0)+21.92938/ (t.d*t.h*t.h) ) /*ELae 
Derbholz (BERGEL 1974)*/

Kronenbreite [m] t.cw = (3.6962+0.0762*t.d)*(1.0-exp(-exp(ln(t.d/21.8046)*1.53))) 
/* Lae (DÖBBELER ET AL 2002) */
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Kronenansatz [m] t.cb = t.h*(1.0-exp(-abs((0.8225-0.4688*t.h/t.d-0.00317*t.d-
0.4282*ln(sp.h100))))) /* Lae (DÖBBELER ET AL 2002) */

Kronentype in Grafik: Kronentyp= 1 (0=Laubholz, 1= Nadelholz) 
Bonität (Höhe im Alter 100) 
[m]

t.si = (sp.h100+0.53515)/(-0.78758+0.38982*ln(t.age)) /* Lae 
(DÖBBELER ET AL 2002) */

Höhe entsprechend der 
Bonität [m] 

Höhe = -0.53515-0.78758*t.si+0.38982*t.si*ln(t.age) /* Lae 
(DÖBBELER ET AL 2002) */

Potentieller Höhenzuwachs 
[m]

ihpot = ((-0.53515-0.78758*t.si+0.38982*t.si*(ln(t.age+5)))-(-
0.53515-0.78758*t.si+0.38982*t.si*(ln(t.age)))) /* Lae 
(DÖBBELER ET AL 2002) */

Höhenzuwachs [m] t.hinc = ((-0.53515-0.78758*t.si+0.38982*t.si*(ln(t.age+5)))-(-
0.53515-0.78758*t.si+0.38982*t.si*(ln(t.age)))) /* Lae 
(DÖBBELER ET AL 2002) */

Höhenzuwachsstreuung [m] herror = 0.082
Grundflächenzuwachs [cm²] t.dinc = exp(-7.1927+0.8621*ln(3.14159265359*(t.cw/2.0)/

(6.0*(t.h-t.cb)^2)*((4.0*(t.h-t.cb)^2 +(t.cw/2)^2)^1.5 - 
(t.cw/2)^3))-0.5193*ln(t.age)-
0.7122*t.c66xy+0.3619*t.c66cxy+0.7316*1.6094) /* Lae 
(DÖBBELER ET AL 2002) */

Durchmesserzuwachsstreuung 
[cm]

herror = 0.629

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = (3.141592*(t.d/200.0)^2.0)*(8400.0/
(3.141592*(t.cw/2.0)^2.0)) /* Lae (DÖBBELER ET AL 2002) */

Maximales Alter [Jahre] MaxAlter = 240
Totholzzersetzung (Faktor) 1.0-((sp.year-t.out-5.0)/50.0)
Zielstärkendurchmesser [cm] 60.0
Höhe der 1. Durchforstung 
[m]

12.0

Mäßige Durchforstung 
[m;NB°]

12.0;0.7;20.0;20.0;0.75;26.0;26.0;0.8;100.0

Farbe (RGB) 255;0;0

Tabelle 27: Baumart 812 – Japanische Lärche (Larix kaempferi)
Durchmessergenerierung [cm] t.d = (-2.492+1.104*sp.dg)*(((6.9/(-

2.492+1.104*sp.dg))^(3.418+0.353*sp.dg-0.192*dmax))-ln(1.0-
random))^(1.0/(3.418+0.353*sp.dg-0.192*dmax)) /* Fichte 
(NAGEL u. BIGING 1995) */

Einheitshöhenkurve [m] t.h = 1.3+(sp.hg-1.3)*exp(0.53934489*(1.0-
(sp.dg/t.d)))*exp(4.16512685*((1.0/sp.dg)-(1.0/t.d))) /*JLae 
(NAGEL 1999*/

Höhenvariabilität [m] t.hv = -0.6810186+0.523771*ln(sp.dg) /* JLae (ALBERT 
2000)*/
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Volumenfunktion [m³] t.v = 3.141592*t.h*(t.d/200)^2*(0.5073+7.41736/(t.h*t.h)-
7.57701/ (t.h*t.d)-0.32268*ln(t.d)/ln(10.0)+ 
0.30583*ln(t.h)/ln(10.0)+20.75427/ (t.d*t.h*t.h) ) /*JLae 
Derbholz (BERGEL 1973)*/

Kronenbreite [m] t.cw = 2.3805+0.1073*t.d /* JLae (DÖBBELER ET AL 2002) */
Kronenansatz [m] t.cb = t.h*(1.0-exp(-abs((-1.041+0.4789*t.h/t.d-

0.00914*t.d+0.6266*ln(sp.h100))))) /* JLae (DÖBBELER ET 
AL 2002) */

Kronentype in Grafik: Kronentyp= 1 (0=Laubholz, 1= Nadelholz) 
Bonität (Höhe im Alter 100) 
[m]

t.si = sp.h100/(1.88062*(1.0-exp(-0.009296*t.age))^0.6345) /* 
JLae (WESTPHAL 1997) */

Höhe entsprechend der Bonität 
[m] 

Höhe = 1.88062*t.si*(1.0-exp(-0.009296*t.age))^0.6345 /* JLae 
(WESTPHAL 1997) */

Potentieller Höhenzuwachs [m] ihpot = ((1.88062*t.si*(1.0-exp(-
0.009296*(t.age+5.0)))^0.6345)-(1.88062*t.si*(1.0-exp(-
0.009296*t.age))^0.6345)) /* JLae (WESTPHAL 1997) */

Höhenzuwachs [m] t.hinc = t.h*((((1.88062*t.si*(1.0-exp(-
0.009296*(t.age+5.0)))^0.6345)-(1.88062*t.si*(1.0-exp(-
0.009296*t.age))^0.6345))/sp.h100)+(0.0188*(t.hinc^3.5922))) /
* JLae (DÖBBELER ET AL 2002) */

Höhenzuwachsstreuung [m] herror = 0.082
Grundflächenzuwachs [cm²] t.dinc = exp(-8.1122+1.3016*ln((3.141593*(t.cw/2.0)/(6.0*(t.h-

t.cb)^2.0))*(((4.0*(t.h-t.cb)^2.0+(t.cw/2.0)^2.0)^1.5)-
(t.cw/2.0)^3.0))-0.6979*ln(t.age)-
0.5081*t.c66xy+0.4766*t.c66cxy+0.3520*ln(5.0)) /* JLae 
(DÖBBELER ET AL 2002) */

Durchmesserzuwachsstreuung 
[cm]

herror = 0.57

Maximale Dichte der 
Grundfläche [m²/ha]

MaxDichte = (3.141592*(t.d/200.0)^2.0)*(22800.0/
(3.141592*(t.cw/2.0)^2.0)) /* JLae (DÖBBELER ET AL 2002) 
*/

Maximales Alter [Jahre] MaxAlter = 240
Totholzzersetzung (Faktor) 1.0-((sp.year-t.out-5.0)/30.0)
Zielstärkendurchmesser [cm] 60.0
Höhe der 1. Durchforstung [m] 12.0
Mäßige Durchforstung 
[m;NB°]

12.0;0.75;18.0;18.0;0.80;24.0;24.0;0.85;100.0

Farbe (RGB) 254;0;0

Tabelle 28: Grass 999 – Vergrasung wird wie eine Baumart geführt, Code 999 kann nicht geändert  
werden

Durchmessergenerierung [cm] t.d = 
Einheitshöhenkurve [m] t.h = 
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Höhenvariabilität [m] t.hv = 
Volumenfunktion [m³] t.v = 0
Kronenbreite [m] t.cw = 
Kronenansatz [m] t.cb = 
Kronentype in Grafik: Kronentyp= 0 (0=Laubholz, 1= Nadelholz) 
Bonität (Höhe im Alter 100) [m] t.si = 1
Höhe entsprechend der Bonität [m] Höhe = 1
Potentieller Höhenzuwachs [m] ihpot = 0
Höhenzuwachs [m] t.hinc = 0
Höhenzuwachsstreuung [m] herror = 0.0
Grundflächenzuwachs [cm²] t.dinc = 0
Durchmesserzuwachsstreuung [cm] herror = 0.0
Maximale Dichte der Grundfläche [m²/ha] MaxDichte = 0.003848*6000/5.0
Maximales Alter [Jahre] MaxAlter = 900
Totholzzersetzung (Faktor) 0.0
Zielstärkendurchmesser [cm] 999.0
Höhe der 1. Durchforstung [m] 120.0
Mäßige Durchforstung [m;NB°] 12.0;0.55;18.0;18.0;0.60;24.0;24.0;0.65;100.0
Farbe (RGB) 255;102;55

5.2 Ingrowth Model

Tabelle 29: Koeffizienten für Wahrscheinlichkeit von Einwuchs nach führender Baumart

Führende Baumart p0 p1
Eiche 0.237 -0.6551
Buche 0.2551 -0.5288

ALH/ALN 0.2446 -0.4435
Fichte 0.1659 -0.6086

Douglasie 0.1800 -0.8022
Kiefer 0.2946 -0.2795
Lärche 0.2829 -0.7482

nE=e p0+p1⋅c66Kl
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Tabelle 30: Koeffizienten zur Bestimmung der Anzahl der einwachsenden Bäume in Abhängigkeit  
der führenden Baumart

Führende Baumart p0 p1
Eiche 3.2874 -1.1275
Buche 3.14664 -0.94789

ALH/ALN 2.80772 -0.87383
Fichte 2.7331 -0.7096

Douglasie 2.7331 -0.7096
Kiefer 2.9338 -1.1701
Lärche 2.5012 -0.4793

− Bestimmung der Baumart

Tabelle 31: Führende Baumart Eiche
c66kl Art 111 112 211 221 321 342 411 411 431 451 511 711 731 811

0.1 p 0.254 0.724 0.752 0.752 0.752 0.752 0.921 0.970 0.970 0.985 1.00 1.0 1.0 1.0
0.3 p 0.203 0.811 0.849 0.862 0.862 0.862 0.875 0.875 0.888 0.901 0.964 0.989 1.000 1.000
0.5 p 0.177 0.673 0.786 0.821 0.821 0.821 0.835 0.870 0.870 0.898 0.990 0.997 0.997 0.997
0.7 p 0.169 0.662 0.859 0.887 0.887 0.887 0.901 0.901 0.901 0.915 0.985 0.985 0.985 0.999
0.9 p 0.043 0.532 0.766 0.787 0.787 0.787 0.808 0.808 0.808 0.851 1.000 1.000 1.000 1.000
1.1 p 0.217 0.608 0.847 0.890 0.890 0.933 0.933 0.933 0.933 0.955 0.998 0.998 0.998 0.998
1.3 p 0.000 0.333 0.666 0.666 0.666 0.777 0.777 0.777 0.777 0.999 0.999 0.999 0.999 0.999

1.5+> p 0.000 0.250 0.625 0.750 0.875 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

Tabelle 32: Führende Baumart Buche (Teil 1)
c66kl Art 111 112 211 221 311 321 331 342 365
0.1 p 0.007 0.007 0.918 0.918 0.918 0.918 0.918 0.918 0.918
0.3 p 0.008 0.008 0.942 0.942 0.942 0.942 0.942 0.942 0.942
0.5 p 0.000 0.008 0.919 0.919 0.919 0.919 0.919 0.919 0.923
0.7 p 0.030 0.060 0.872 0.872 0.872 0.885 0.889 0.893 0.893
0.9 p 0.046 0.059 0.934 0.954 0.954 0.954 0.954 0.954 0.954
1.1 p 0.008 0.008 0.969 0.969 0.969 0.969 0.969 0.969 0.969
1.3 p 0.000 0.000 0.961 0.961 0.969 0.969 0.969 0.977 0.977
1.5 +> p 0 0 1 1 1 1 1 1 1

Tabelle 33: Führende Baumart Buche (Teil2)
c66k
l Art 411 441 451 452 511 513 521 611 711 811

0.1 p 0.940 0.944 0.944 0.944 0.996 0.996 0.996 0.996 0.996 1.000
0.3 p 0.965 0.965 0.965 0.965 0.988 0.988 0.988 0.992 0.992 1.000
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0.5 p 0.935 0.935 0.951 0.951 0.991 0.995 0.995 0.995 0.995 1.000
0.7 p 0.906 0.906 0.906 0.906 0.974 0.974 0.974 0.983 0.992 1.000
0.9 p 0.954 0.954 0.954 0.954 0.980 0.980 1.000 1.000 1.000 1.000
1.1 p 0.969 0.969 0.977 0.977 1.000 1.000 1.000 1.000 1.000 1.000
1.3 p 0.977 0.977 0.985 0.985 1.00 1.00 1.00 1.00 1.00 1.00
1.5 + 
> p 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00

Tabelle 34: Führende Baumart Alh oder Aln (Teil1)
c66kl Art 111 112 211 221 311 321 342 354 411 412 421
0.1 p 0.000 0.051 0.229 0.229 0.229 0.263 0.263 0.271 0.618 0.643 0.685
0.3 p 0.116 0.195 0.256 0.262 0.268 0.268 0.268 0.268 0.628 0.701 0.738
0.5 p 0.016 0.016 0.154 0.154 0.154 0.178 0.194 0.194 0.560 0.576 0.592
0.7 p 0.021 0.032 0.117 0.117 0.213 0.266 0.266 0.266 0.745 0.745 0.766
0.9 p 0.000 0.028 0.334 0.334 0.334 0.445 0.445 0.445 0.528 0.528 0.556
1.1 p 0.107 0.107 0.357 0.357 0.393 0.429 0.429 0.429 0.608 0.608 0.679
1.3 + 
> p 0.053 0.053 0.421 0.421 0.421 0.474 0.474 0.474 0.579 0.579 0.579

Tabelle 35: Führende Baumart Alh oder Aln (Teil2)
c66kl Art 411 441 451 452 511 513 521 611 711 811
0.1 p 0.940 0.944 0.944 0.944 0.996 0.996 0.996 0.996 0.996 1.000
0.3 p 0.965 0.965 0.965 0.965 0.988 0.988 0.988 0.992 0.992 1.000
0.5 p 0.935 0.935 0.951 0.951 0.991 0.995 0.995 0.995 0.995 1.000
0.7 p 0.906 0.906 0.906 0.906 0.974 0.974 0.974 0.983 0.992 1.000
0.9 p 0.954 0.954 0.954 0.954 0.980 0.980 1.000 1.000 1.000 1.000
1.1 p 0.969 0.969 0.977 0.977 1.000 1.000 1.000 1.000 1.000 1.000
1.3 p 0.977 0.977 0.985 0.985 1.00 1.00 1.00 1.00 1.00 1.00
1.5 + 
>

p 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00

Tabelle 36: Führende Baumart Fichte (Teil1)

c66kl Art 112 113 211 321 411 412 421 441 451

0.1 p 0.000 0.000 0.065 0.065 0.102 0.102 0.102 0.107 0.107

0.3 p 0.031 0.031 0.080 0.080 0.127 0.127 0.132 0.135 0.148
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0.5 p 0.016 0.020 0.134 0.134 0.250 0.259 0.259 0.259 0.270

0.7 p 0.003 0.003 0.152 0.169 0.218 0.218 0.218 0.218 0.256

0.9 p 0.000 0.000 0.101 0.101 0.163 0.163 0.163 0.163 0.192

1.1 p 0.000 0.000 0.254 0.254 0.282 0.296 0.296 0.296 0.352

1.3 p 0.0 0.0 0.5 0.5 0.5 0.5 0.5 0.5 0.5
1.5 p 0.0 0.0 0.4 0.4 0.4 0.4 0.4 0.4 0.4

Tabelle 37: Führende Baumart Fichte (Teil1)
c66kl Art 511 512 525 551 611 711 811 812
0.1 p 0.986 0.986 0.986 0.986 0.986 1.000 1.000 1.000
0.3 p 0.964 0.967 0.967 0.967 0.972 0.995 1.000 1.000
0.5 p 0.964 0.964 0.964 0.966 0.982 0.995 0.997 1.000
0.7 p 0.950 0.950 0.953 0.953 0.960 0.995 0.998 1.000
0.9 p 0.966 0.966 0.966 0.966 0.980 0.999 0.999 1.000
1.1 p 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000
1.3 p 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0
1.5 + > p 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0

Tabelle 38: Führende Baumart Douglasie
c66kl Art 111 112 211 411 511 611 711
0.1 p 0 0 0 0 0 1 1
0.3 p 0.000 0.000 0.018 0.036 0.179 1.000 1.000
0.5 p 0.000 0.071 0.071 0.071 0.214 0.928 0.999
0.7 p 0.048 0.048 0.096 0.191 0.381 1.000 1.000
0.9 + > p 0 0 0 0 0 1 1

Tabelle 39: Führende Baumart Kiefer (Teil1)
c66kl Art 111 112 113 211 311 411 412 421 431 441 451
0.1 p 0.139 0.139 0.139 0.139 0.139 0.153 0.153 0.153 0.153 0.153 0.153
0.3 p 0.010 0.074 0.074 0.077 0.080 0.202 0.202 0.202 0.202 0.205 0.205
0.5 p 0.005 0.012 0.015 0.024 0.024 0.135 0.154 0.154 0.154 0.154 0.163
0.7 p 0.002 0.007 0.007 0.042 0.042 0.194 0.203 0.205 0.207 0.207 0.230
0.9 p 0.006 0.006 0.006 0.031 0.031 0.156 0.162 0.168 0.168 0.168 0.180
1.1 p 0.05 0.05 0.05 0.05 0.05 0.50 0.50 0.50 0.50 0.50 0.50
1.3 + p 0.0 0.0 0.0 0.0 0.0 0.5 0.5 0.5 0.5 0.5 0.5
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Tabelle 40: Führende Baumart Kiefer (Teil2)
c66kl Art 511 513 531 611 711 811 812
0.1 p 0.167 0.167 0.167 0.167 1.000 1.000 1.000
0.3 p 0.384 0.384 0.384 0.387 0.995 0.998 0.998
0.5 p 0.413 0.415 0.417 0.451 0.996 0.999 1.001
0.7 p 0.580 0.580 0.580 0.594 0.994 0.999 0.999
0.9 p 0.680 0.680 0.680 0.711 0.999 0.999 0.999
1.1 p 0.95 0.95 0.95 0.95 1.00 1.00 1.00
1.3 + > p 1.0 1.0 1.0 1.0 1.0 1.0 1.0

Tabelle 41: Führende Baumart Lärche

c66kl Art 112 211 321 411 421 422 441 451 511 611 711 811 812

0.1 p 0.083 0.500 0.500 0.750 0.750 0.833 0.833 0.833 0.833 0.833 0.916 0.999 0.999

0.3 p 0.022 0.435 0.435 0.522 0.522 0.522 0.544 0.544 0.587 0.739 0.782 0.999 0.999

0.5 p 0.014 0.405 0.434 0.535 0.564 0.564 0.564 0.636 0.882 0.896 0.925 0.997 0.997

0.7 p 0.000 0.852 0.852 0.852 0.852 0.852 0.852 0.868 0.901 0.950 0.966 0.982 0.998

0.9 p 0.000 0.824 0.824 0.883 0.883 0.883 0.883 0.912 0.971 0.971 0.971 1.000 1.000

1.1+> p 0 1 1 1 1 1 1 1 1 1 1 1 1

5.3 Taper Functions
Java Klasse: treegross.base.TaperByBrink
Für die Sortimentierung werden die Schaftformfunktionen von SCHMIDT (2001) 
verwendet.

Modifizierte Brinkfunktion (Laubholzarten)

Tabelle 42: Buche

Koeffizient Wert Std. Fehler t-Wert
k 0.6946140 0.00975345 71.2173
p 0.0862735 0.00427386 20.1863

ForestSimulator BWINPro 7.6 – Englisch Manual – Version April 2011



Appendix 66

q 0.1359840 0.00304893 44.6007

Residual Std. Fehler (mm) 0.683244 bei 6331 Freiheitsgraden

Tabelle 43: Eiche

Koeffizient Wert Std. Fehler t-Wert
k 0.5698770 0.01181670 48.2263
p 0.0450652 0.00354560 12.7102
q 0.2452940 0.00724047 33.8782

Residual Std. Fehler (mm) 0.504138 bei 9421 Freiheitsgraden

Painfunktion (Nadelholzarten)

Tabelle 44: Fichte

Koeffizient Wert Std. Fehler t-Wert Pr(>|t|)
a0 -0.223 0.0615 -3.632 0.0003
a1 1.595 0.0138 115.608 0.0000
a2 -3.155 0.0667 -47.307 0.0000
b0 0.512 0.0333 15.386 0.0000
b1 -0.158 0.0075 -21.042 0.0000
b2 -0.502 0.0362 -13.847 0.0000

Residual Std. Fehler (mm) 0.504 bei 9763 Freiheitsgraden

Multiples Bestimmtheitsmaß 0.997

F-Statistik 591400 bei 6 und 9763 Freiheitsgraden, p-Wert = 0

Tabelle 45: Douglasie

Koeffizient Wert Std. Fehler t-Wert Pr(>|t|)
a0 -0.5828 0.0251 -23.2380 0.0000
a1 1.4423 0.0046 315.5793 0.0000
a2 -2.1807 0.0301 -72.4895 0.0000
b0 0.4369 0.0135 32.2455 0.0000
b1 -0.2008 0.0025 -79.1233 0.0000
b2 -0.2836 0.0167 -17.0032 0.0000

Residual Std. Fehler (mm) 0.5274 bei 28350 Freiheitsgraden
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Multiples Bestimmtheitsmaß 0.9970

F-Statistik 1575000 bei 6 und 28350 Freiheitsgr., p-Wert = 0

Tabelle 46: Kiefer

Koeffizient Wert Std. Fehler t-Wert Pr(>|t|)
a0 -1.7258 0.0194 -88.9947 0.0000
a1 1.3311 0.0072 185.5373 0.0000
a2 -0.7016 0.0350 -20.0722 0.0000

b0  n. signifikant
b1 -0.2142 0.0035 -60.5993 0.0000
b2 0.1306 0.0188 6.9432 0.0000

Residual Std. Fehler (mm) 0.4822 bei 10723 Freiheitsgraden
Multiples Bestimmtheitsmaß 0.9976

F-Statistik 882000 bei 5 und 10723 Freiheitsgraden, p-Wert = 0
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